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Introduction to Global VPN Client

• Global VPN Client overview on page 6

• Global VPN Client features on page 6

• Global VPN Client Enterprise on page 8

• About this guide on page 8

• Text conventions on page 9

• Message icons on page 9

Global VPN Client overview 
The Dell™ SonicWALL™ Global VPN Client creates a Virtual Private Network (VPN) connection between your 
computer and the corporate network to maintain the confidentiality of private data. The Global VPN Client 
provides an easy-to-use solution for secure, encrypted access through the Internet for remote users. 

Custom developed by Dell SonicWALL, the Global VPN Client combines with GroupVPN on Dell SonicWALL 
Internet Security Appliances to dramatically streamline VPN deployment and management. Using Dell 
SonicWALL’s Client Policy Provisioning technology, the SonicOS administrator establishes the VPN connections 
policies for the Global VPN Clients. The VPN configuration data is transparently downloaded from the Dell 
SonicWALL VPN Gateway (Dell SonicWALL Internet Security Appliance) to Global VPN Clients, removing the 
burden of provisioning VPN connections from the user.

For configuring your Dell SonicWALL security appliance to support Global VPN Clients using SonicOS GroupVPN, 
see the SonicOS Administration Guide for the firmware version running on your Dell SonicWALL security 
appliance (your VPN gateway appliance).

Topics:

• Global VPN Client features on page 6

• Global VPN Client Enterprise on page 8

Global VPN Client features
The Dell SonicWALL Global VPN Client delivers a robust IPsec VPN solution with these features:

• Easy to Use - Provides an easy-to-follow Installation Wizard to quickly install the product, an easy-to-
follow Configuration Wizard with point-and-click activation of VPN connections, and streamlined 
management tools to minimize support requirements.

• Multiple Language Support - The Global VPN Client user interface supports English, Simplified Chinese, 
Japanese, Korean, and Brazilian Portuguese. The UI automatically displays in the Windows display 
language.

• Client Policy Provisioning - Using only the IP address or Fully Qualified Domain Name (FQDN) of the Dell 
SonicWALL VPN gateway, the VPN configuration data is automatically downloaded from the Dell 
SonicWALL VPN gateway via a secure IPsec tunnel, removing the burden from the remote user of 
provisioning VPN connections.
Dell SonicWALL Global VPN Client 4.9 Administration Guide
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• XAUTH Authentication with RADIUS - Provides added security with user authentication after the client 
has been authenticated via a RADIUS server.

• VPN Session Reliability - Allows automatic redirect in case of a Dell SonicWALL VPN gateway failure. If a 
Dell SonicWALL VPN gateway is down then the Global VPN Client can go through another Dell SonicWALL 
VPN gateway.

• Multiple Subnet Support - Allows Global VPN Client connections to more than one subnet in the 
configuration to increase networking flexibility.

• Third-Party Certificate Support - Supports VeriSign, Entrust, Microsoft, and Netscape Certificate 
Authorities (CAs) for enhanced user authentication.

• Tunnel All Support - Provides enhanced security by blocking all traffic not directed to the VPN tunnel to 
prevent Internet attacks from entering the corporate network through a VPN connection.

• DHCP over VPN Support - Allows IP address provisioning across a VPN tunnel for the corporate network 
while allowing WAN DHCP for Internet Access from the ISP.

• Secure VPN Configuration - Critical Global VPN Client configuration information is locked from the user 
to prevent tampering.

• AES and 3DES Encryption - Supports 168-bit key 3DES (Data Encryption Standard) and AES (Advanced 
Encryption Standard) for increased security. AES requires SonicOS 2.0 or higher on the Dell SonicWALL 
VPN gateway appliance.

• GMS Management - Allows Global VPN Client connections to be managed by Dell SonicWALL’s award-
winning Global Management System (GMS).

• Multi-Platform Client Support - Supports 32-bit and 64-bit versions of Windows: Windows 10, Windows 
8, Windows 8.1, Windows 7, and Windows Vista.

• NAT Traversal - Enables Global VPN Client connections to be initiated from behind any device performing 
NAT (Network Address Translation). The Dell SonicWALL Global VPN Client encapsulates IPsec VPN traffic 
to pass through NAT devices, which are widely deployed to allow local networks to use one external IP 
address for an entire network.

• Automatic Reconnect When Error Occurs - Allows the Global VPN Client to keep retrying a connection 
if it encounters a problem connecting to a peer. This feature allows the Global VPN Client to 
automatically make a connection to a Dell SonicWALL VPN gateway that is temporarily disabled, without 
manual intervention.

• Ghost Installation for Large Scale Installations - Enables the Global VPN Client’s virtual adapter to get 
its default address after installation and then create a ghost image.

• NT Domain Logon Script Support - Allows Global VPN Clients to perform Windows NT domain 
authentication after establishing a secure IPsec tunnel. The Dell SonicWALL VPN gateway passes the 
logon script as part of the Global VPN Client configuration. This feature allows the VPN user to have 
access to mapped network drives and other network services.

• Dual Processor Support - Enables the Global VPN Client to operate on dual-processor computers.

• Group Policy Management - Global VPN Clients access can be customized and restricted to specific 
subnet access (Requires SonicOS Enhanced).

• Hub and Spoke VPN Access - Allows IP addressing from Dell SonicWALL VPN gateway’s DHCP Server to 
Global VPN Client for configuring a different subnet for all remote Global VPN Clients than the subnet of 
the LAN. Makes hub-and-spoke VPN access simpler. When a Global VPN Client successfully authenticates 
with the central site, it receives a virtual IP address that also grants it access to other trusted VPN sites.

• Default VPN Connections File - Enables the SonicOS administrator to configure and distribute the 
corporate VPN connections with the Global VPN Client software to streamline VPN client deployment. 

• Single VPN Connection to any Dell SonicWALL Secure Wireless Appliance for Roaming - Allows users to 
use a single VPN connection to access the networks of multiple Dell SonicWALL Secure Wireless 
appliances.

• Automatic Configuration of Redundant Gateways from DNS - When an IPsec gateway domain name 
resolves to multiple IP addresses, the Global VPN Client (version 2.1.0.0 or higher) uses the IP addresses 
in the list as failover gateways.
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• Tunnel State Display Enhancement - The Global VPN Client provides information about the state of VPN 
tunnels. In addition to the states of enabled, disabled, and connected, the Global VPN Client indicates 
when tunnels are authenticating, provisioning, and connecting.

• Tunnel Status Pop-Up Window - The Global VPN Client alerts users when tunnels are connected or 
disconnected by displaying a small pop-up window.

• Smart Card and USB Token Authentication - The Global VPN Client is integrated with the Microsoft 
Cryptographic Application Program (MS CryptoAPI or MSCAPI), which enables the Global VPN Client to 
support user authentication using digital certificates on Smart cards and USB tokens.

• NAT-T RFC 3947 Support - Allows for automatic detection of NAT along the path between two IKE peers 
during IKE Phase 1 negotiation. On detection of NAT in middle, packets are UDP encapsulated using port 
4500.

• DNS Redirect - DNS queries to DNS suffix associated with Virtual Adapter are not sent on the physical 
adapter.

• Tunnel All Support Enhancement - Provides the ability to route clear traffic to directly connected 
network interfaces that are configured with the Route All policy, which is generally used in the WLAN 
zone.

• Program Auto-Start on VPN Connection - Automatically launches a program, with optional arguments, 
when successful VPN connections are established, as specified in the Connection Properties dialog.

Global VPN Client Enterprise
Global VPN Client Enterprise provides the same functionality as the Global VPN Client with the added feature of 
license sharing.

About this guide
The Dell SonicWALL Global VPN Client Administration Guide provides complete documentation on installing, 
configuring, and managing the Dell SonicWALL Global VPN Client. This guide also provides instructions for Dell 
SonicWALL Global VPN Client Enterprise. 

For configuring your Dell SonicWALL security appliance to support Global VPN Clients using SonicOS GroupVPN, 
see the SonicOS Administration Guide for the firmware version running on your Dell SonicWALL security 
appliance (your VPN gateway appliance).

Topics:

• Text conventions on page 9

• Message icons on page 9
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Text conventions  

Message icons
These special messages refer to noteworthy information, and include a symbol for quick identification:        

Convention Use

Bold Highlights items you can select on the Global VPN Client interface 
or the SonicOS management interface.

Menu Item > Menu Item Indicates a multiple step menu choice. For example, “select File > 
Open” means “select the File menu, and then select the Open 
item from the File menu.

Screen Text Indicates text as you would see it on a computer screen or would 
enter on a command line. For example, myDevice> show alerts 

WARNING: Important information that warns about a potential for property damage, personal injury, 
or death

CAUTION: Important information that cautions about features affecting firewall performance, 
security features, or causing potential problems with your Dell SonicWALL appliance.

TIP: Useful information about security features and configurations on your Dell SonicWALL appliance. 

IMPORTANT: Important information on a feature that requires callout for special attention.

NOTE: Supporting information on a feature.

MOBILE: Useful information about mobile apps for your Dell SonicWALL appliance. 

VIDEO: Links to videos containing further information about a feature on your Dell SonicWALL appliance.
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2

Getting started with Global VPN
Client

• Installing the Global VPN Client on page 10

• Upgrading Global VPN Client from a previous version on page 13

• Installing Global VPN Client with a ghost application on page 14

• Command-line options for installation on page 15

• Launching the Global VPN Client on page 15

• Specifying Global VPN Client launch options on page 17

• Managing the Global VPN Client system tray icon on page 18

This section provides information about installing, upgrading, and launching the Dell SonicWALL Global VPN 
Client. 

Installing the Global VPN Client 
The Dell SonicWALL Global VPN Client uses an easy-to-use wizard to guide you through the installation process. 

The Dell SonicWALL Global VPN Client operates on 32-bit and 64-bit versions of Windows 10, Windows 8.1, 
Windows 8, Windows 7, Windows XP, and Windows Vista client operating systems. 

The Global VPN Client is supported on all Dell SonicWALL security appliances running Gen3 (6.6 and higher), 
Gen4 (1.0 and higher), Gen5 (5.0 and higher), and Gen6 (6.1 and higher) SonicOS firmware versions.  

Using the Setup Wizard
This section explains how to install the Dell SonicWALL Global VPN Client program using the Setup Wizard. 

To use the Setup Wizard, perform the following steps:

1 Download the self-extracting installer, GVCSetupXX.exe (where XX is either 32 for 32-bit Windows 
platforms or 64 for 64-bit Windows platforms), from MySonicWALL. 

NOTE: Installing the Global VPN Client on Windows XP or later requires Administrator rights.

NOTE: For information on the number of Dell SonicWALL Global VPN Client connections supported by your 
Dell SonicWALL appliance and Global VPN Client licensing for your appliance, see Global VPN Client 
licenses on page 52.

IMPORTANT: Remove any installed 3rd Party VPN client program before installing the latest Dell 
SonicWALL Global VPN Client.

If you have Dell SonicWALL Global VPN Client version 4.8.6 or earlier installed, you must uninstall that 
version before installing version 4.9.x. 
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2 Double-click GVCSetupXX.exe. The Setup Wizard launches.

3 Click Next to continue installation of the VPN Client. The License Agreement page displays.

4 Select the I Agree radio button.
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5 Click Next. The Installation Folder Selection page displays.

6 Optionally, to specify a custom installation location, click Browse. 

a Select the location.

b Click OK.

7 Click the Disk Cost button to see the disk space requirements.

8 Under Install SonicWALL Global VPN Client for yourself, or for anyone who uses this computer, select 
either Everyone or Just me.

9 Click Next. The next page indicates that the installer is ready to begin installation. 

10 Click Next. The Global VPN Client is being installed page displays, which indicates the status of the 
installation.
Dell SonicWALL Global VPN Client 4.9 Administration Guide
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11 Wait while the Dell SonicWALL Global VPN Client files are installed on your computer. When the 
installation is complete, the Global VPN Client has been successfully installed page displays.

12 Click Close to exit the wizard. After a successful installation, what happens next depends on whether 
you had saved connections:

• If you saved the connection configurations from a previous version of the Dell SonicWALL Global 
VPN Client when uninstalling it, the Global VPN Client launches, and your default connection 
prompts you for login credentials. 

• If no previous connections exist, the New Connection Wizard launches automatically. This only 
occurs the first time the Global VPN Client starts up. For more information, see Creating a VPN 
connection using the New Connection Wizard on page 20,  

Upgrading Global VPN Client from a 
previous version 
Upgrades are supported from Dell SonicWALL Global VPN Client version 4.9.x to higher versions. It is not 
necessary to uninstall the previous version first.

During an upgrade, your configured connections and virtual MAC address are preserved. The Setup Wizard does 
not ask you to confirm the license agreement, installation location, or other setup questions, but uses the 
information you provided during the previous installation.

To upgrade to the latest Dell SonicWALL Global VPN Client:

1 Download the self-extracting installer, GVCSetupXX.exe (where XX is either 32 for 32-bit Windows 
platforms or 64 for 64-bit Windows platforms), from MySonicWALL. 

TIP: You can configure the Global VPN Client to launch automatically every time you log 
onto your computer, on the General tab in the View > Options page. For more information, 
see Specifying Global VPN Client launch options on page 17

NOTE: If you have Dell SonicWALL Global VPN Client version 4.8.6 or earlier installed, you must uninstall 
that version before installing version 4.9.x. The 4.9.x installer does not allow upgrading from version 4.8.6 
or earlier.
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2 Double-click GVCSetupXX.exe. The Setup Wizard launches.

3 Click Yes to continue with the upgrade process. The wizard installs Global VPN Client using the settings 
from the previous installation.

The Restart message displays.

4 Click:

• Yes to restart your computer after the installation completes,

• No to restart it later. 

Installing Global VPN Client with a ghost 
application 
The installation process is the same when using a ghost application as it is for normal installation. The FIRST 
time Global VPN Client is started after a ghost install, it randomly creates a unique MAC address for the Dell 
SonicWALL VPN Adapter. 

NOTE: The upgrade does not take effect until the computer is restarted.

CAUTION: DO NOT OPEN the Global VPN Client application after installing it but BEFORE you ghost it. 
If you open the Global VPN Client BEFORE using ghost, you receive the same MAC address on each 
ghosted installation for the Dell SonicWALL VPN Adapter, resulting in network conflicts.
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Command-line options for installation
There are several command line options available for Dell SonicWALL Global VPN Client installation.

All options are case-insensitive and must be preceded by a forward slash (/):

• /Q – Quiet mode. A normal (non-silent) installation of the Dell SonicWALL Global VPN Client receives the 
necessary input from the user in the form of responses to dialogs. However, a silent installation does not 
prompt the user for any input, but instead, uses the defaults for every option. Simply type in the 
following where XX is either 32 for 32-bit Windows platforms or 64 for 64-bit Windows platforms: 

GVCSetupXX.exe /q 

• /T – Specify a temporary working folder in which to place any temporary files generated during the 
installation process. The T option must be followed by a colon (:) and the full path to the folder that you 
want to use. For example, type in the following:

GVCSetupXX.exe /t:C:\TemporaryFiles

• /C – Place all files extracted (MSI Installer file) from the install package into the folder specified in the T 
option. The C option is only valid when used together with the T option. For example, type one of the 
following:

GVCSetupXX.exe /c /t:C:\TemporaryFiles 
GVCSetupXX.exe /T:C:\TemporaryFiles /c 

Launching the Global VPN Client
To launch the Dell SonicWALL Global VPN Client:

1 Select Start > Programs > Global VPN Client.
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2 You can do any of the following:

• To close the Global VPN Client dialog, but have your established VPN connections remain active, 
click X, press Alt+F4, or choose File > Close. 

A message appears notifying you that the Global VPN Client program and any enabled connections 
remain active after the dialog is closed. 

If you don’t want this notification message to display every time you close the Global VPN Client 
dialog:

a Select the Don’t show me this message again checkbox.

b Click OK.

• To open the Global VPN Client dialog:

• Double-click the Global VPN Client icon in the system tray.

• Right-click the icon, and the select Open Global VPN Client.

CAUTION: Exiting the Dell SonicWALL Global VPN Client from the system tray icon menu disables any 
active VPN connections.

TIP: You can:

• Change the default launch setting for Dell SonicWALL Global VPN Client; see Specifying 
Global VPN Client launch options on page 17 for more information.

• Create a shortcut to automatically launch the Global VPN Client dialog and make the VPN 
connection from the desktop, taskbar, or Start menu. See Global VPN Client licenses on 
page 52 for more information.

• Launch the Global VPN Client from the command line, See Using the Global VPN Client CLI 
on page 62 for more information.
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Specifying Global VPN Client launch 
options 
You can specify how the Dell SonicWALL Global VPN Client launches and what notification windows appear using 
the controls in the General tab of the Options dialog. Choose View > Options to display the Options dialog.

The General tab includes the following settings to control the launch of the Global VPN Client:

• Start this program when I log in - Launches the Dell SonicWALL Global VPN Client when you log into your 
computer.

• Warn me before enabling a connection that will block my Internet traffic. Activates a Connection 
Warning message notifying you that the VPN connection will block local Internet and network traffic.

• Remember the last window state (closed or open) the next time the program is started - Allows the 
Global VPN Client to remember the last window state (open or closed) the next time the program is 
started. For example, a user can launch the Global VPN Client from the system tray without opening a 
window on the desktop.

• When closing the connections window - Specifies how the Global VPN Client behaves when the window 
is closed: 

• Minimize the window (restore it from the task bar) - Minimizes the window to taskbar and 
restores it from the taskbar.

• Hide the window (re-open it from the tray icon) - The default setting that hides the Global VPN 
Client window when you close it. You can open the Global VPN Client from the program icon in 
the system tray. Enabling this setting also displays the Show the notification when I hide the 
connections window checkbox. 

• Show the notification when I hide the connections window - Selecting this checkbox 
activates the SonicWALL Global VPN Client Hide Notification window whenever you close 
the Global VPN Client window while the program is still running. The message tells you 
that the Global VPN Client program continues to run after you close (hide) the window.
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Managing the Global VPN Client system 
tray icon 
When you launch the Global VPN Client window, the program icon appears in the system tray on the taskbar.

This icon provides program and VPN connection status indicators as well as a menu for common Dell SonicWALL 
Global VPN Client commands. Right-clicking on the Global VPN Client icon in the system tray displays a menu of 
options for managing the program.

• Open Global VPN Client - Opens the program window.

• Enable - Displays a menu of VPN connections that can be enabled.

• Disable - Displays a menu of VPN connections that can be disabled.

• Open Log Viewer - Opens the Log Viewer to view informational and error messages. See Understanding 
the Global VPN Client log on page 44 for more information on the Log Viewer.

• Open Certificate Manager - Opens the Certificate Manager. See Managing certificates on page 42 for 
more information on the Certificate Manager.

• Exit - Exits the Global VPN Client window and disables any active VPN connections.

Moving the mouse pointer over the Global VPN Client icon in the system tray displays the number of enabled 
VPN connections.

The Global VPN Client icon in the system tray also acts as a visual indicator of data passing between the Global 
VPN Client and the Dell SonicWALL gateway.
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3

Adding VPN connections

• Understanding VPN connections on page 19

• Creating a VPN connection using the New Connection Wizard on page 20

• Importing a VPN configuration file on page 22

• Using Global VPN Client from a different workstation on page 22

Understanding VPN connections
The Global VPN Client allows multiple connections to be configured at the same time, whether they are 
provisioned from multiple gateways or imported from one or more files. Because connections may be 
provisioned from multiple gateways, each connection explicitly states allowed behavior in the presence of any 
connection policy conflicts. You may have VPN connections that don’t allow other VPN connections or Internet 
and network connections while the VPN policy is enabled.

The VPN connection policy includes all the parameters necessary to establish secure IPsec tunnels to the 
gateway. A connection policy includes Phase 1 and Phase 2 Security Associations (SA) parameters:

• Encryption and authentication proposals

• Phase 1 identity payload type

• Phase 2 proxy IDs (traffic selectors)

• Client Phase 1 credential

• Allowed behavior of connection in presence of other active connections

• Client caching behavior

Adding a new VPN connection is easy because Dell SonicWALL’s Client Policy Provisioning automatically provides 
all the necessary configuration information to make a secure connection to the local or remote network. The 
burden of configuring the VPN connection parameters is removed from the Global VPN Client user. VPN 
connections can be created using three methods:

• Download the VPN policy from the Dell SonicWALL VPN Gateway to the Global VPN Client using the New 
Connection Wizard. This wizard walks you through the process of locating the source of your 
configuration information and automatically downloads the VPN configuration information over a secure 
IPsec VPN tunnel. 

• Import a VPN policy file into the Dell SonicWALL Global VPN Client. The VPN policy is sent to you as a .rcf 
file, which you install using the Import Connection dialog.

• Install the default.rcf file as part of the Global VPN Client software installation or add it after 
installing the Global VPN Client. If the Dell SonicWALL VPN Gateway administrator included the 
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default.rcf file as part of the Global VPN Client software, one or more preconfigured VPN 
connections are automatically created when the program is installed.    

Creating a VPN connection using the 
New Connection Wizard 
The following instructions explain how to use the New Connection Wizard to automatically download a VPN 
connection policy for the Global VPN Client from a local or remote Dell SonicWALL VPN gateway.

To use the New Connection Wizard:

1 Choose Start > Programs > Global VPN Client. The first time you open the Dell SonicWALL Global VPN 
Client, the New Connection Wizard launches automatically.

2 If the New Connection Wizard does not display, to launch it, click the New Connection  button. 

NOTE: Creating a default.rcf file and distributing it with the Global VPN Client software allows 
the Dell SonicWALL VPN Gateway administrator to streamline VPN client deployment and allows 
users to quickly establish VPN connections. If a default.rcf file is included with the downloaded 
Global VPN Client software, the VPN policy configured by the Dell SonicWALL VPN Gateway 
administrator is used to create a connection automatically when the client software is installed. 
For more information on creating the default.rcf file, see Using the default.rcf file for Global 
VPN Client on page 54.

NOTE: To facilitate the automatic provisioning of Global VPN Clients, configure your Dell 
SonicWALL appliance be configured with GroupVPN . For instructions on configuring your appliance 
with GroupVPN, see the SonicOS Administration Guide.

NOTE: For instructions on importing a certificate into the Global VPN Client, see Using certificates 
on page 42.
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3 Click Next. The New Connection page displays.

4 Enter the IP address or FQDN of the gateway in the IP Address or Domain Name field. The information 
you type in the IP Address or Domain Name field appears in the Connection Name field. 

5 Optionally, if you want a different name for your connection, type the new name for your VPN 
connection in the Connection Name field. 

6 Click Next. The Completing the New Connection Wizard page displays.

7 Optionally, select either or both:

• Create a desktop shortcut for this connection if you want to create a shortcut icon on your 
desktop for this VPN connection.

• Enable this connection when the program is launched if you want to automatically establish 
this VPN connection when you launch the Dell SonicWALL Global VPN Client. 

8 Click Finish. The new VPN connection appears in the Global VPN Client window. 
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Importing a VPN configuration file
A VPN connection can be created as a file and sent to you by the Dell SonicWALL VPN gateway administrator. 
This VPN configuration file has the filename extension .rcf. If you received a VPN connection file from your 
administrator, you can install it using the Import Connection dialog.

The VPN policy file is in the XML format to provide more efficient encoding of policy information. Because the 
file can be encrypted, pre-shared keys can also be exported in the file. The encryption method is specified in 
the PKCS#5 Password-Based Cryptography Standard from RSA Laboratories and uses Triple-DES encryption and 
SHA-1 message digest algorithms.  

To add a VPN connection by importing a connection file provided by your gateway 
administrator: 

1 Choose Start > Programs > Global VPN Client.

2 Select File > Import. The Import Connection dialog displays.

3 Either:

• Type the file path for the configuration file in the Specify the name of the configuration file to 
import field. 

• Click the Browse  button to locate the file. 

4 If the file is encrypted, enter the password in the If the file is encrypted, specify the password field.

5 Click OK.

Using Global VPN Client from a different 
workstation 
Using the Dell SonicWALL Global VPN Client to connect to a Microsoft Network has certain limitations. Typically, 
when a computer is attached to a Microsoft Network it has a persistent network connection to the domain 
controller that is used to verify the user credentials. When the user credentials have been verified by the 
domain controller, the computer then creates a locally cached profile that is used when the domain controller is 
not available. However, the Dell SonicWALL Global VPN Client provides an ad hoc secure network connection 
over the Internet back to the Microsoft Network containing the domain controller and thus is not a persistent 
connection. Since the remote computer cannot connect to the domain controller to verify the logon credentials 
until the connection is provided by the Dell SonicWALL Global VPN Client, the logon fails unless a locally cached 
profile is available.

NOTE: If the .rcf file exported from the Dell SonicWALL appliance is encrypted, you must have the 
password to import the configuration file into the Global VPN Client.
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The following steps illustrate the classic problem:

1 A Global VPN Client session must be established to communicate remotely with a Microsoft domain 
controller.

2 Global VPN Client can only be launched after you have logged on to the workstation. Because there is no 
way for the Global VPN Client to connect before you log on, you cannot use it for domain logon when 
initially logging on.

3 If you have logged on to the workstation before, there will be a locally cached profile that is used to log 
on.

a You can then start the Global VPN Client, and a connection to the domain is established.

b After connecting to the domain, you can run logon scripts, change password, access domain 
resources, etc.

c When you log off, the Global VPN Client terminates, preventing domain communications.

4 If you have never logged on to the workstation before, there will not be a locally cached profile, so logon 
will not be possible.

Because logging off (Step c) terminates the Dell SonicWALL Global VPN Client, it has historically precluded a 
different user from logging on and creating a new locally cached profile. This has the undesirable effect that 
only a user with a pre-existing (locally cached) profile can log on over the Global VPN Client.

The standard workaround for this is to first connect locally to the domain controller and logon with each 
account expected to use the Dell SonicWALL Global VPN Client. This creates a locally cached profile for each 
account and enables client logon without connection to the Domain Controller.

The unfortunate result of this workaround is that a user without a cached profile on the computer cannot logon 
without a sojourn to the network containing the domain controller. This can be extremely cumbersome in 
certain situations such as being located in a distant satellite office and trying to get back to the main office.

Workaround — forced creation of a new locally 
cached profile
The workaround is to create an induced local profile, and then log on to the Microsoft domain using the Dell 
SonicWALL Global VPN Client. 

To create an induced local profile:

1 Log on to the workstation with any locally cached profile (for example, mydomain\user1 or a local 
machine account). The locally cached profiles are usually stored in the C:\Documents and Settings 
directory. You should see a folder, called user1, in this path, which contains user1’s profile.

2 Launch the Dell SonicWALL Global VPN Client.

3 After the Dell SonicWALL Global VPN Client establishes a connection and the workstation can 
communicate with the domain controller, you can create another locally cached profile. You can use the 
runas command to create a locally cached profile for a new user (for example, mydomain\user2) 
while using the Global VPN Client connection provided by user1.

4 From a command prompt, type runas /user:mydomain\user2 explorer.exe (substitute your 
actual domain for mydomain and actual username for user2). You can use notepad.exe instead of 
explorer.exe if you prefer.

5 At the prompt, enter the domain password for user2.

6 It will take anywhere from a few seconds to a few minutes to create the local profile for user2, and to 
launch the explorer.exe program. You may quit the explorer.exe program after it launches.

7 The C:\Documents and Settings directory should now contain a folder for user2.

8 Close the Global VPN Client.
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9 Log off as user1 from the workstation. You will see the familiar Log On to Windows dialog.

10 Log onto the workstation as user2 using the newly created locally cached profile.

11 Launch the Dell SonicWALL Global VPN Client. The user2 profile will now provide the credentials for all 
domain access (including running logon scripts).

12 You can repeat this procedure as many times as necessary to create additional profiles.

It is also possible to change an expired user password with this procedure if you have another account available 
to make the Global VPN Client connection back to the domain controller. A simple way to change passwords is 
from the Windows Security dialog, accessed by:

1 Pressing Ctrl+Alt Delete. 

2 Select Change a password ….

3 Enter the old password.

4 Enter the new password.

5 Confirm the new password.

6 Click the Arrow button.
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4

Making VPN connections

• Overview on page 25

• Accessing redundant VPN gateways on page 25

• Enabling a VPN connection on page 26

• Establishing multiple connections on page 27

• Entering a Pre-Shared Key on page 27

• Selecting a certificate on page 28

• Providing Username and Password Authentication on page 29

• Creating a connection shortcut on page 29

• Connection warning on page 30

Overview
Making a VPN connection from the Global VPN Client is easy because the configuration information is managed 
by the Dell SonicWALL VPN gateway. The SonicOS (VPN gateway) administrator sets the parameters for what is 
allowed and not allowed with the VPN connection. For example, for security reasons, the administrator may not 
allow multiple VPN connections or the ability to access the Internet or local network while the VPN connection 
is enabled.

The Global VPN Client supports two IPsec authentication modes: 

• IKE using Preshared Secret 

• IKE using 3rd Party Certificates. 

Preshared Secret is the most common form of the IPsec authentication modes. If your VPN connection policy 
uses 3rd party certificates, you use the Certificate Manager to configure the Global VPN Client to use digital 
certificates. 

A Pre-Shared Key (also called a Shared Secret) is a predefined password that the two endpoints of a VPN tunnel 
use to set up an IKE (Internet Key Exchange) Security Association. This field can be any combination of 
alphanumeric characters with a minimum length of 4 characters and a maximum of 128 characters. Your Pre-
Shared Key is typically configured as part of your Global VPN Client provisioning. If it is not, you are prompted 
to enter it before you log on to the remote network.

Accessing redundant VPN gateways
The Global VPN Client supports redundant VPN gateways by manually adding the peer in the Peers page of the 
VPN connection Properties window. The Global VPN Client adds automatic support for redundant VPN gateways 
if the IPsec gateway’s domain name resolves to multiple IP addresses. For example, if 
gateway.yourcompany.com resolves to 67.115.118.7, 67.115.118.8, and 67.115.118.9, the Global 
VPN Client cycles through these resolved IP addresses until it finds a gateway that responds, allowing multiple 
IP addresses to be used as failover gateways. If all the resolved IP addresses fail to respond, Global VPN Client 
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switches to the next peer, if another peer is specified in the Peers page of the VPN connection Properties 
dialog. See Connection Properties Peers settings on page 34 for more information.

Enabling a VPN connection
Enabling a VPN connection with the Dell SonicWALL Global VPN Client is a transparent two phase process. Phase 
1 enables the connection, which completes the ISAKMP (Internet Security Association and Key Management 
Protocol) negotiation. Phase 2 is IKE (Internet Key Exchange) negotiation, which establishes the VPN tunnel for 
sending and receiving data.

When you enable a VPN connection, the following information is displayed in the Status column of the Global 
VPN Client window:

• Disabled changes to Connecting.

• Connecting changes to Authenticating when the Enter Username/Password dialog displays.

• Authenticating changes to Connecting when the user enters the username and password.

• Connecting changes to Provisioning.

• Provisioning changes to Connected once the VPN connection is fully established. A green checkmark is 
displayed on the VPN connection icon.

When the VPN connection is established, a pop-up notification from the Global VPN Client system tray icon 
displays: Connection Name, Connected to IP address, and Virtual IP Address.

If an error occurs during the VPN connection, Error appears in the Status column, and an error mark (a red X) 
appears on the VPN Connection icon. A VPN connection that does not successfully complete all phase 2 
connections displays a yellow warning symbol on the Connection icon.

To establish a VPN connection using the Global VPN Client:

1 Enable a VPN connection using one of the following methods:

• If you selected Enable this connection when the program is launched in the New Connection 
Wizard, the VPN connection is automatically established when you launch the Dell SonicWALL 
Global VPN Client.

• If your VPN connection is not automatically established when you launch the Global VPN 
Client, choose one of the following methods to enable a VPN connection:

• Double-click the VPN connection. 

• Right-click the VPN connection icon and select Enable from the menu.

• Select the VPN connection and press Ctrl+B.

• Select the VPN connection, and click the Enable button on the toolbar

• Select the VPN connection, and then choose File > Enable.

• If the Global VPN Client icon is displayed in the system tray, right-click the icon and then select 
Enable > connection name. The Global VPN Client enables the VPN connection without 
opening the Global VPN Client window.

NOTE: When configuring redundant VPN gateways, the Group VPN policy attributes (such as pre-shared 
keys and the attributes on the Peer Information page) must be the same for every gateway if the 
gateway’s FQDN resolves to multiple IP addresses. However, if you set up multiple peers on the Peers 
page, then each peer gateway can have its own settings.

I

NOTE: f the Global VPN Client does not establish the VPN connection, you can use the Log Viewer to view 
the error messages to troubleshoot the problem. See Understanding the Global VPN Client log on page 44 
for more information.
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2 Depending on how the VPN connection is configured, these dialogs may be displayed: 

• Cannot Enable Connection – see Establishing multiple connections on page 27

• Enter Pre-Shared Secret – see Entering a Pre-Shared Key on page 27

• Enter Username and Password – see Providing Username and Password Authentication on page 29

• Connection Warning – see Connection warning on page 30

Establishing multiple connections
You can have more than one connection enabled at a time but it depends on the connection parameters 
established at the VPN gateway. If you attempt to enable a subsequent VPN connection with a currently enabled 
VPN connection policy that does not allow multiple VPN connections, the Cannot Enable Connection message 
appears informing you the VPN connection cannot be made because the currently active VPN policy does not 
allow multiple active VPN connections. The currently enabled VPN connection must be disabled before enabling 
the new VPN connection.

Entering a Pre-Shared Key
Depending on the attributes for the VPN connection, if no default Pre-Shared Key is used, you must have a Pre-
Shared Key provided by the gateway administrator to make your VPN connection. If the default Pre-Shared Key 
is not included as part of the connection policy download or file, the Enter Pre-Shared Key dialog appears to 
prompt you for the Pre-Shared key before establishing the VPN connection.
Dell SonicWALL Global VPN Client 4.9 Administration Guide
Making VPN connections

27



To enter a Pre-Shared Key:

1 Type your Pre-Shared Key in the Pre-shared Key field. The Pre-Shared Key is masked for security.

2 Optionally, if you want to make sure you are entering the correct Pre-Shared Key, select Don’t hide the 
pre-shared key. The Pre-Shared Key you enter appears unmasked in the Pre-shared Key field. 

3 Click OK.

Selecting a certificate
If the Dell SonicWALL VPN Gateway requires a Digital Certificate to establish your identity for the VPN 
connection, the Select Certificate dialog appears. This dialog lists all the available certificates installed on 
your Global VPN Client. 

 

To select a certificate:

1 Do one of the following:

• Select the certificate from the menu.

• If you have a certificate that has not been imported into the Global VPN Client using Certificate 
Manager, click Import Certificate. 

2 Click OK. 

TIP: If you select this option, be sure to unselect it when you’ve verified the Pre-Shared Key.

NOTE: For more information on using the Certificate Manager, see Managing certificates on page 42.
Dell SonicWALL Global VPN Client 4.9 Administration Guide
Making VPN connections

28



Providing Username and Password 
Authentication 
The VPN gateway typically specifies the use of XAUTH for determining GroupVPN policy membership by 
requiring a username and password either for authentication against the gateway’s internal user database or via 
an external RADIUS service. 

If the Dell SonicWALL VPN gateway is provisioned to prompt you for the username and password to enter the 
remote network, the Enter Username and Password dialog appears. 

 

To enter a username and password:

1 Type your username and password. 

2 Optionally, if permitted by the gateway, select Remember Username and Password to cache your 
username and password to automatically log in for future VPN connections. 

3 Click OK to continue with establishing your VPN connection.

Creating a connection shortcut 

To streamline enabling a VPN connection, you can place a VPN connection on the desktop, taskbar, or Start 
menu. You can also place the connection at any other location on your system.

To create a shortcut:

1 Select the VPN connection for which to create a shortcut in the Global VPN Client window.

2 Choose File > Create Shortcut.

3 Select the shortcut option you want: On the Desktop, On the Task Bar, In the Start Menu, or Select a 
Location.

You can also right-click the VPN connection and then choose Create Shortcut > shortcut option. 

TIP: Create a Desktop shortcut for the Dell SonicWALL Global VPN Client program for easy access to all 
your connections.
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Connection warning
If the VPN connection policy allows only traffic to the gateway, the Connection Warning message appears, 
warning you that only network traffic destined for the remote network at the other end of the VPN tunnel is 
allowed. Any network traffic destined for local network interfaces and the Internet is blocked. 

You can disable the Connection Warning message from displaying every time you enable the VPN connection by 
checking If yes, don’t show this dialog again. 

Click Yes to continue with establishing your VPN connection.
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5

Configuring VPN connection
properties

• Displaying the Connections Properties dialog on page 31

• Connection Properties General settings on page 32

• Connection Properties User Authentication settings on page 33

• Connection Properties Peers settings on page 34

• Connection Properties Status settings on page 37

Displaying the Connections Properties 
dialog
The Connection Properties dialog includes the controls for configuring a specific VPN connection profile. To 
open the Connection Properties dialog, choose one of the following methods:

• Select the connection and choose File > Properties.

• Right click the connection and select Properties.

• Select the connection and click the Properties button on the Global VPN Client window toolbar.

The Connection Properties dialog includes the General, User Authentication, Peers and Status tabs.
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Connection Properties General settings
The General tab in the Connection Properties dialog displays the following settings:

• Name - Displays the name of your VPN connection.

• Description - Displays a pop-up text about the connection. The text appears when your mouse pointer 
moves over the VPN connection.

• Peer Defined Network Settings - Defines the status of Tunnel All support. These settings are controlled 
at the Dell SonicWALL VPN gateway.

• Other traffic allowed - If enabled, your computer can access the local network or Internet 
connection while the VPN connection is active.

• Default traffic tunneled to peer - If activated, all network traffic not routed to the Dell 
SonicWALL VPN gateway is blocked. When you enable the VPN connection with this feature 
active, the Connection Warning message appears.

• Use virtual IP address - Allows the VPN Client to get its IP address via DHCP through the VPN 
tunnel from the gateway.

• Enable this connection when the program is launched - Establishes the VPN connection as the default 
VPN connection when you launch the Dell SonicWALL Global VPN Client.

• Immediately establish security when connection is enabled - Negotiates the first phase of IKE as soon 
as the connection is enabled instead of waiting for network traffic transmission to begin. This setting is 
enabled by default.

• Automatically reconnect when an error occurs - With this feature enabled, if the Global VPN Client 
encounters a problem connecting to the peer, it keeps retrying to make the connection. This feature 
allows a Global VPN Client to make a connection to a VPN connection that is temporarily disabled, 
without manual intervention. 
Dell SonicWALL Global VPN Client 4.9 Administration Guide
Configuring VPN connection properties

32



If the connection error is due to an incorrect configuration, such as the DNS or IP address of the peer 
gateway, then the connection must be manually corrected. Check the Log Viewer to determine the 
problem and then edit the connection. 

This option is enabled by default. If an error occurs with this option disabled during an attempted 
connection, the Global VPN Client logs the error, displays an error message dialog, and stops the 
connection attempt.

• Automatically reconnect when waking from sleep or hibernation - Automatically re-enables the VPN 
connection after the computer wakes from a sleep or hibernation state. This setting is disabled by 
default.

• Execute logon script when connected - After logging into the Dell SonicWALL VPN Gateway and 
establishing a secure tunnel, performs any action configured in the logon script.

• Run the following command when connection is established - Allows a program to be automatically 
executed, with optional arguments, when successful VPN connections are established.

• Restrict the size of the first ISAKMP packet sent - This option can be used when the Global VPN Client 
gets an error such as, “The peer is not responding to phase 1 ISAKMP requests” when attempting to 
connect. This error can occur when the ISAKMP packet is fragmented due to its size, but the network 
device (router) does not allow a fragmented packet when establishing the VPN connection.

Connection Properties User 
Authentication settings
The User Authentication page allows you to specify a username and password when user authentication is 
required by the gateway. If the Dell SonicWALL VPN gateway does not support the saving (caching) of a 
username and password, the settings in this page are not active and the message The peer does not allow 
saving of username and password appears at the bottom of the page.

• Remember my username and password - Enables the saving of your username and password for 
connecting to the Dell SonicWALL VPN gateway.
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• Username - Enter the username provided by your gateway administrator.

• Password - Enter the password provided by your gateway administrator.

Connection Properties Peers settings
The Peers page allows you to specify an ordered list of VPN gateway peers that this connection can use 
(multiple entries allow a VPN connection to be established through multiple VPN gateways). An attempt is made 
to establish a VPN connection to the given VPN gateway peers in the order they appear in the list.

To add a peer:

1 Click Add. 

2 In the Peer Information dialog, enter the IP address or DNS Name in the IP Address or DNS Name field.

3 Click OK.

To edit a peer entry:

1 Select the peer name.

2 Click Edit. 

3 In the Peer Information dialog, make your changes.

4 Click OK.

To change the order of the peer list:

1 Select a peer name

2 Click Move Up or Move Down.
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To delete a peer entry:

1 Select the peer entry.

2 Click Remove.

Peer Information dialog
The Peer Information dialog allows you to add or edit peer information.

• IP Address or DNS Name - Specifies the peer VPN gateway IP address or DNS name. 

• Use the default gateway as the peer IP address - Specifies the default gateway as the peer IP address. 
The Global VPN Client gets the default gateway from the routing table.

• Response Timeout - Specifies the maximum amount of time to wait for a response to a sent packet. 
After this time expires, the sent packet is considered lost and the packet is retransmitted. The valid 
range is 1-10 seconds.

• Maximum Attempts - Specifies the maximum number of times the same packet is sent before 
determining that the peer is not responding. The valid range is 1-10 attempts.

• Dead Peer Detection - Select from:

• Automatic - This is traffic-based DPD. If Global VPN Client does not receive response data (one-
way traffic), then Global VPN Client exchanges heartbeat packets to detect if the peer gateway is 
alive. If there is no heartbeat packet response for the configured number of failed checks in DPD 
Settings, then Global VPN Client tries to re-initiate IKE negotiations. This setting is enabled by 
default.

• Forced On - Performs DPD periodically. The Global VPN Client exchanges heartbeat packets to 
detect if the peer gateway is alive. If there is no heartbeat packet response for the configured 
number of failed checks in DPD Settings, then Global VPN Client tries to re-initiate IKE 
negotiations. 

• Disabled - DPD is disabled. No heartbeat packets are exchanged. This prevents Global VPN Client 
from detecting when the gateway is unavailable.
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• DPD Settings - Displays the Dead Peer Detection Settings dialog.

• Check for dead peer every - choose from 3, 5, 10, 15, 20, 25, or 30 seconds.

• Assume peer is dead after - choose from 3, 4, or 5 Failed Checks.

• NAT Traversal - Choose one of the following three options:

• Automatic - Automatically determines whether to use UDP encapsulation of IPsec packets 
between the peers. 

• Forced On - Forces the use of UDP encapsulation of IPsec packets even when there is no 
NAPT/NAT device in between the peers.

• Disabled - Disables use of UDP encapsulation of IPsec packets between the peers.

• LAN Settings - Displays the LAN Settings dialog for specifying the setting used when this connection is 
enabled over the LAN. 

Type the IP address in the Next Hop IP Address field to specify the next hop IP address of a different 
route than the default route. Leaving the setting as zeros instructs the Global VPN Client to use the 
default route.
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Connection Properties Status settings
The Status page shows the current status of the connection.

• Connection: 

• Status - Indicates whether VPN connection is enabled or disabled.

• Peer IP Address - Displays the IP address of the VPN connection peer.

• Duration - Displays connection time.
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• Details - Displays the Connection Status Details dialog, which specifies the negotiated phase 1 
and phase 2 parameters as well as the status of all individual phase 2 security associations (SAs).

• Activity:

• Packets - Displays number of packets sent and received through the VPN tunnel.

• Bytes - Displays number of bytes sent and received through the VPN tunnel.

• Reset - Resets the Packets and Bytes values to zero, from which these counts immediately 
resume.

• Virtual IP Configuration:

• IP Address - The IP address assigned via DHCP through the VPN tunnel from the VPN gateway.

• Subnet Mask - The subnet mask for the virtual IP address.

• Renew - Renews the DHCP lease.
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Managing VPN connections

• About VPN connections on page 39

• Arranging connections on page 39

• Renaming a connection on page 39

• Deleting a connection on page 40

• Selecting All connections on page 40

• Checking the status of VPN connections on page 40

• Disabling a VPN connection on page 41

About VPN connections
The Dell SonicWALL Global VPN Client supports as many VPN connections as you need. To help you manage these 
connections, the Global VPN Client provides the connection management tools described in this section.

Arranging connections
Over time, as the number of VPN connections can increase in the Global VPN Client window, you may want to 
arrange them for quicker access. You can arrange your VPN connections in the Global VPN Client window by 
choosing View > Sort by:

• Name - Sorts the connections by connection name.

• Peer - Sorts the connections by peer name.

• Status - Sorts the connections by connection status.

• Ascending - Sorts the connections in ascending order, such as A-Z, if enabled, and in descending order, 
such as Z-A, if disabled. The default sorting is by Name in Ascending order.

Renaming a connection
To rename a connection, select the connection and choose File > Rename, then type in the new name. You can 
also right-click the connection and choose Rename from the menu. 
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Deleting a connection

To delete a connection, do one of these:

• Select the connection and then press the Delete key. 

• Choose File > Delete. 

• Right-click the connection name and choose Delete. 

Selecting All connections
Choosing View > Select All or pressing Ctrl+A selects all the connections in the Global VPN Client window.

Checking the status of VPN connections 
The Dell SonicWALL Global VPN Client includes a variety of indicators to determine the status of your VPN 
connections. The main Global VPN Client window lists your VPN connections and their respective status: 
Disabled, Enabled, Connected, or Error.

• A successfully connected VPN policy is indicated by a green check mark on the Policy icon. 

• A VPN policy that doesn’t successfully complete all phase 2 connections displays a yellow warning on the 
Policy icon.

• A VPN policy that cannot be successfully connected displays an error mark (red X) on the Policy icon.

• The Global VPN Client icon in the system tray displays a visual indicator of data passing between the 
Global VPN Client and the gateway.

• The Status tab in the Properties dialog displays more detailed information about the status of an active 
VPN connection. To display the Status tab for any VPN connection, use one of the following methods:

• Double-click the active VPN connection.

• Select the VPN connection, then press Ctrl+T.

• Select the VPN connection, then click the Status button on the toolbar.

IMPORTANT: You cannot delete an active VPN connection. Disable the VPN connection first, then delete it.
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• Right-click the VPN connection in the Global VPN Client window and select Status.

 

Disabling a VPN connection 
Disabling a VPN connection terminates the VPN tunnel. You can disable a VPN connection using any of the 
following methods:

• Right-click the VPN connection in the Global VPN Client window, and select Disable.

• Right-click the Global VPN Client icon on the system tray, and choose Disable > connection.

• Select the connection, then press Ctrl+B. 

• Select the connection, and click the Disable button on the toolbar in the Global VPN Client window.

TIP: For more information on the Status page, see Connection Properties Status settings on page 
37.
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Using certificates

• Obtaining certificate information on page 42

• Managing certificates on page 42

Obtaining certificate information
If digital certificates are required as part of your VPN connection policy, your gateway administrator must 
provide you with the required information to import the certificate. You then need to import the certificate in 
the Global VPN Client using the Certificate Manager.  

Managing certificates
The Certificate Manager allows you to manage digital certificates used by the Dell SonicWALL Global VPN Client 
for VPN connections. If your VPN gateway uses digital certificates, you must import the CA and Local 
Certificates into the Certificate Manager. 

CAUTION: If digital certificates are required as part of your VPN connection policy, your VPN gateway 
administrator must provide you with the required certificates.
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To open the Certificate Manager for managing certificates:

1 Click the View menu.

2 Select Certificates in the Global VPN Client window.

3 In the Select Certificate Group drop-down menu, select one of these types of certificates: 

• User – The local digital certificates used to establish the VPN Security Association.

• CA – The digital certificates used to validate the user certificates. 

• Trusted Root CA – Is used to validate the CA Certificates.

4 Select the certificate in the list and then do one of these:

• Click the Import button in the Certificate Manager window to display the Import Certificate 
window to import a certificate file.

• Click the Remove button to delete the selected certificate.

• Click the Details button to view the selected certificate details.

TIP: For more information on using certificates for your VPN on the Dell SonicWALL appliance, see the 
SonicOS Administration Guide.
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Troubleshooting the Global VPN
Client

• Tools for troubleshooting on page 44

• Understanding the Global VPN Client log on page 44

• Configuring the log on page 47

• Generating a Help report on page 49

• Accessing Dell SonicWALL Global VPN Client technical support on page 50

• Viewing Help topics on page 51

• Uninstalling the Global VPN Client on page 51

Tools for troubleshooting
The Dell SonicWALL Global VPN Client provides tools for troubleshooting your VPN connections:

• Log Viewer – Understanding the Global VPN Client log on page 44

• Help Report – Configuring the log on page 47

• Dell SonicWALL’s Support site – Accessing Dell SonicWALL Global VPN Client technical support on page 50

• Dell SonicWALL Global VPN Client help system – Accessing Dell SonicWALL Global VPN Client technical 
support on page 50

• Global VPN Client uninstall – Uninstalling the Global VPN Client on page 51

Understanding the Global VPN Client log
The Global VPN Client Log window displays messages about Global VPN Client activities. You can save the 
messages as well as manage them.

Topics:

• Opening the Log Viewer window on page 45

• Saving the current log on page 45

• Managing log messages on page 46
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Opening the Log Viewer window

To open the Log Viewer window:

1 Do one of these:

• Click the Log Viewer button on the Global VPN Client window toolbar. 

• Choose View > Log Viewer.

• Press Ctrl+L. 

The Log Viewer window displays this information:

• Type - The icon indicating the type of message: 

• Information - 

• Warning - 

• Error - 

• Time - Date and time the message was generated.

• Peer - The IP address or FQDN of the peer.

• Message - Text of the message describing the event.

Saving the current log
Click the Save button to save the current log to a .txt file. When you save the current log to a file, the Global 
VPN Client automatically adds a Help Report containing useful information regarding the condition of the Dell 
SonicWALL Global VPN Client as well as the system it’s running on for troubleshooting. The Help Report 
information is inserted at the beginning of the log file. See Generating a Help report on page 49 for more 
information.  

TIP: For a complete listing of Log Viewer messages, see Log Viewer messages on page 64 .
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Managing log messages
The Log Viewer provides the following features to help you manage log messages:

• To save a current log to a .txt file, click the Save button on the toolbar, press Ctrl+S, or choose File > 
Save. When you save a Log Viewer file, the Global VPN Client automatically adds a report containing 
useful information regarding the condition of the Dell SonicWALL Global VPN Client as well as the system 
it is running on.

• To select all messages, press Ctrl+A or choose Edit > Select All.

• To copy log contents for pasting into another application, select the messages you want to copy, then 
press Ctrl+C or choose Edit > Copy.

• To display less detailed information in the log viewer, click the Filter Messages button on the toolbar or 
choose View > Filter Messages.

• To search the log messages for a character string, do one of the following:

• Click the Find icon  on the toolbar.

• Choose Edit > Find and enter the string in the Find dialog. 

In the dialog, you can select Match Whole Word Only, Match Case, and Up or Down for the 
search direction. 

• Click the Find Next icon to search. Once a string is entered in the Find dialog, you can click the 
X to close the dialog, then use the Find Next and Find Previous icons in the toolbar.

• To clear current log information, do one of these:

• Click Clear on the toolbar. 

• Press Crtl+X. 

• Choose Edit > Clear.

• To hide or show the toolbar in the Log Viewer window, choose View > Toolbar to toggle the toolbar on or 
off.

• To hide or show the status bar in the Log Viewer window, choose View > Status Bar to toggle the status 
bar on or off.
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Configuring the log
The Logging tab in the View > Options dialog specifies the settings for configuring the Global VPN Client Log 
behavior.

• Maximum number of log messages to keep - Specifies the maximum number of log messages kept in the 
log file.

• Log ISAKMP header information - Enables the logging of ISAKMP header information.

• Log dead peer detection packets - Enables the logging of dead peer detection packets.

• Log NAT keep-alive packets - Enables the logging of NAT keep-alive packets.

• Enable automatic logging of messages to file - Enables automatic logging of messages to a file as 
specified in the Auto-Logging window.

• Settings - Displays the Auto-Logging dialog; see Configuring Auto-Logging on page 47.

Configuring Auto-Logging
Clicking on Settings displays the Auto-Logging dialog for specifying settings for automatic logging of messages 
to a file. Log files are saved as text (.txt) files. 
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• Enter the name of the auto-log file - Specifies the file in which to save the logging messages. Clicking 
on the Browse button allows you to specify the location of your auto-log file. If only a file name is 
specified (no path is given in the file name), the log file is created in the user’s TEMP directory. 

• View Auto-Log File - Displays the entire log file up to 71,000 lines.

• Overwrite existing file when auto-logging starts - Overwrites the existing auto-log file when auto-
logging is started.

• Set size limit on auto-log file - Limits the maximum size of the log file.

• Maximum auto-log file size - Specifies the maximum file size in KB or MB.

• When auto-log size limit is reached - Specifies the action to take when the auto-log file reaches the 
maximum size:

• Ask me what to do - When the log file reaches the maximum size, prompts to choose either Stop 
auto-logging or Overwrite auto-log file.

• Stop auto-logging - Stops auto-logging when the maximum file size is reached.

• Overwrite auto-log file - Overwrites the existing auto-log file after the maximum file size is 
reached.
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Generating a Help report
Choosing Help > Generate Report in the Global VPN Client window displays the Global VPN Client Report 
dialog.

Generate Report creates a report containing useful information for getting help in solving any problems you 
may be experiencing. The report contains information regarding the condition of the Dell SonicWALL Global VPN 
Client as well as the system it is running on:

• Version information

• Drivers

• System information

• IP addresses

• Route table

• Current log messages
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To view the report in your default text editor window, click View.

• To save the report to a text file, click Save As.

• To send the report via email, click Send. 

• To close the report window without taking any action, click Don’t Send.

Accessing Dell SonicWALL Global VPN 
Client technical support 
Dell SonicWALL’s comprehensive support services protect your network security investment and offer the 
support you need — when you need it. Dell SonicWALL Global VPN Client support is included as part of the 
support program of your Dell SonicWALL network security appliance. 

• Selecting Help > Technical Support accesses the Dell SonicWALL Support site at:

https://support.software.dell.com 

• The Dell SonicWALL Support site offer a full range of support services including extensive online 
resources and information on Dell SonicWALL’s enhanced support programs. You can purchase/activate 
Dell SonicWALL Support Services through your MySonicWALL account at: 

http://www.mysonicwall.com 
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Viewing Help topics
Selecting Help > Help Topics displays the Dell SonicWALL Global VPN Client help system window. You can access 
help topics using the following options:

• Contents - displays help in a table of contents view.

• Index - displays help in an alphabetical topic view.

• Search - allows you to search the help system using keywords.

Uninstalling the Global VPN Client 
You can easily uninstall the Dell SonicWALL Global VPN Client and choose to save or delete your VPN connections 
as part of the uninstall process. 

To uninstall the Dell SonicWALL Global VPN Client:

1 Launch the Windows Control Panel

2 Double-click Add/Remove Programs (Windows XP) or click Programs and Features (Windows 7 and 
above).

3 Select the Global VPN Client.

4 Click Remove. 

5 In the Confirm File Deletion dialog, click Yes or OK to confirm the removal of the Dell SonicWALL Global 
VPN Client.

6 If you want to:

• Delete all your existing VPN connection profiles, choose Delete all individual user profiles. If you 
leave this setting unchecked, the VPN connection profiles are saved and appear again when you 
install the Dell SonicWALL Global VPN Client at another time.

• Retain the same Dell SonicWALL VPN Adapter MAC address the next time you install the Global 
VPN Client, choose Retain MAC Address. 

7 Click Next.

8 After the Global VPN Client is removed, restart your computer when prompted to do so.

NOTE: You must exit the Dell SonicWALL Global VPN Client before uninstalling the program.
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Configuring Dell SonicWALL
appliances for Global VPN Clients

• About GroupVPN policies on page 52

• Global VPN Client licenses on page 52

• Group VPN connections supported by each appliance model on page 53

• Activating Your Global VPN Client on page 53

• Downloading Global VPN Client software and documentation on page 53

About GroupVPN policies
The SonicOS GroupVPN policy provides the automatic provisioning of Dell SonicWALL Global VPN Client from the 
Dell SonicWALL security appliance. The GroupVPN policy is only available for Dell SonicWALL Global VPN Clients. 
SonicOS GroupVPN supports two IPsec keying modes: 

• IKE using shared secret 

• IKE using 3rd Party Certificates 

Once you create the GroupVPN policy, you configure GroupVPN to automatically provision Dell SonicWALL Global 
VPN Clients by downloading the policy, or exporting the policy file for manual installation in the Dell SonicWALL 
Global VPN Client.

Global VPN Client licenses
Global VPN Client Licensing is based on the number of simultaneous Global VPN Client connections to a Dell 
SonicWALL appliance. If the number of simultaneous Global VPN Client connections is exceeded, SonicOS does 
not allow any additional Global VPN Client connections. Once the number of simultaneous Global VPN Client 
drops below the license limit, new Global VPN connections can be established.

NOTE: For information on configuring GroupVPN on the Dell SonicWALL appliance to support Dell 
SonicWALL Global VPN Client, refer to the SonicOS Administration Guide. All Dell SonicWALL product 
documentation is available from the Support page at:

https://support.software.dell.com. 
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Group VPN connections supported by 
each appliance model
Each Dell SonicWALL appliance model supports a different number of Global VPN Client licenses. You can 
purchase Global VPN Client software and Global VPN Client Licenses from your reseller or online at 
mysonicwall.com. 

Activating Your Global VPN Client
To activate and download your Dell SonicWALL Global VPN Client software, you must have a valid 
mysonicwall.com account and your Dell SonicWALL appliance must be registered to your account. If you do not 
have a mysonicwall.com account, or if you have not registered your appliance to your account, create an 
account and then follow the registration instructions at http://www.mysonicwall.com.

To activate your Global VPN Client license: 

1 Log in to your mysonicwall.com account.

2 Select the registered Dell SonicWALL network security appliance. 

3 Select Global VPN Client from the Applicable Services menu.

4 Select Activate.

5 Type in your activation key in the Activation Key field.

6 Click Submit.

Upon successful activation, a confirmation message is displayed. 

Downloading Global VPN Client software 
and documentation

1 In the My Products page, click the name of your Dell SonicWALL appliance on which the Global VPN Client 
license is activated.

2 Select Software Download. If this service is not already activated, click on Agree to activate it.

3 Download the Dell SonicWALL Global VPN Client software and documentation.

TIP: For future reference, record the Serial Number of the Dell SonicWALL appliance. Your license 
activation is now complete.
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Using the default.rcf file for Global
VPN Client

• About the default.rcf file on page 54

• How the Global VPN Client uses the default.rcf file on page 54

• Deploying the default.rcf file on page 55

• Creating the default.rcf file on page 57

• Sample default.rcf file on page 59

• Troubleshooting the default.rcf file on page 61

About the default.rcf file
The default.rcf file allows you to create and distribute preconfigured VPN connections for Dell SonicWALL 
Global VPN Client. You can distribute the default.rcf file with the Global VPN Client software to automatically 
create preconfigured VPN connections for streamlined deployment.

The VPN connections created from the default.rcf file appear in the Global VPN Client window. The Global VPN 
Client user simply enables the VPN connection and after XAUTH authentication with a username and password, 
the policy download is automatically completed.

How the Global VPN Client uses the 
default.rcf file
When the Global VPN Client starts up, the program always looks for the configuration file, Connections.rcf, in 
the C:\Users\<user>\AppData\Roaming\Dell SonicWALL\Global VPN Client\ directory. If this file 
does not exist, the Global VPN Client looks for the default.rcf file in the program install directory, C:\Program 
Files\Dell SonicWALL\Global VPN Client\.

The Global VPN Client reads the default.rcf file, if it exists, and creates the configuration file, 
Connections.rcf, in the C:\Users\<user>\AppData\Roaming\Dell SonicWALL\Global VPN Client\ 
directory. The Connections.rcf file contains all the VPN connection configuration information for the Dell 
SonicWALL Global VPN Client, with sensitive data (user names and passwords) encrypted.
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Deploying the default.rcf file
There are three ways to deploy the default.rcf file for your Dell SonicWALL Global VPN Clients:

• Include the default.rcf file along with the installer software GVCInstallXX.MSI, where XX is either 32, 
for 32-bit Windows platforms or 64, for 64-bit Windows platforms, before running the installer. See 
Including the default.rcf file with the Installer software GVCInstallXX.MSI on page 55.

• Add the default.rcf file to the program install directory before opening the Dell SonicWALL Global VPN 
Client application for the first time. See Adding the Default.rcf file to the Installed Global VPN Client 
Directory on page 56.

• If the Connections.rcf configuration file exists in the user’s configuration file folder, replace it using 
settings from the default.rcf file in the program install directory. See Replacing an existing 
Global VPN Client.rcf with default.rcf settings on page 56.

Including the default.rcf file with the Installer 
software GVCInstallXX.MSI
After you create the default.rcf file, you can include it in the same folder as the MSI installer 
(GVCInstallXX.MSI where XX is either 32, for 32-bit Windows platforms, or 64, for 64-bit Windows platforms) 
before running the installer. The installation process now copies the default.rcf to the program install directory. 
After this installation, when the user launches the Global VPN Client program, the connection(s) defined in 
default.rcf are used to create the configuration file Connections.rcf in the 
C:\Users\<user>\AppData\Roaming\Dell SonicWALL\Global VPN Client\ directory. This is the 
easiest method for Global VPN Client users.

To get the same profile (from default.rcf) to all the users during installation:

1 Export the WAN groupVPN configuration from your Dell SonicWALL network security appliance (the VPN 
Gateway) or create default.rcf if you want multiple connections.

2 Rename the exported configuration file to default.rcf.

3 Extract the GVCInstallXX.MSI from GVCSetupXX.exe (where XX is either 32 for 32-bit Windows 
platforms or 64 for 64-bit Windows platforms) by typing this command line: 

GVCSetupXX.exe /T:<Path where you want MSI to be extracted> /C 

4 Copy the default.rcf file to same directory where you have the GVCInstallXX.MSI (installer file).

5 Launch the installer (GVCInstallXX.MSI). The installation process copies default.rcf to the GVC Install 
directory.

6 After the install is complete and you start the Global VPN Client, it reads the default.rcf and creates the 
defined connections from it.

CAUTION: The default.rcf file must be included in the Global VPN Client installation directory 
C:\Program Files\Dell SonicWALL\Global VPN Client\ for the program to write the 
Connections.rcf file based on the settings defined in the default.rcf file.
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Adding the Default.rcf file to the Installed 
Global VPN Client Directory
After the Global VPN Client software is installed and prior to running the program, the user can add the 
default.rcf file to the Global VPN Client installation directory C:\Program Files\Dell 
SonicWALL\Global VPN Client\. 

When the user launches the Global VPN Client program, the configuration file Global VPN Client.rcf is created 
in the C:\Users\<user>\AppData\Roaming\Dell SonicWALL\Global VPN Client\ directory based 
on the default.rcf file settings.

Replacing an existing Global VPN Client.rcf with 
default.rcf settings
If the configuration file, Connections.rcf, already exists in the C:\Users\<user>\AppData\Roaming\Dell 
SonicWALL\Global VPN Client\ directory, the user can remove this file and add the default.rcf file to the 
Global VPN Client installation directory C:\Program Files\Dell SonicWALL\Global VPN Client\. The 
next time the user launches the Global VPN Client, the Connections.rcf file is created in the 
C:\Users\<user>\AppData\Roaming\Dell SonicWALL\Global VPN Client\ directory based on the 
default.rcf file settings.

CAUTION: The Connections.rcf file is user-specific and in most cases will not work for another user 
running the Dell SonicWALL Global VPN Client, even on the same machine.

CAUTION: Removing an existing Connections.rcf file removes the VPN connections created in the 
Global VPN Client. These VPN connections can be added again from the Global VPN Client into the 
new Connections.rcf file.
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Creating the default.rcf file
You can create your custom default.rcf file with any text editor, such as Windows Notepad.

default.rcf file tag descriptions
Tags that you do not explicitly list in default.rcf are set to the default setting (which is the same behavior as 
when you configure a new VPN connection within the Global VPN Client manually). The default setting for each 
tag is highlighted in bracketed bold text, for example: [default].

<SW_Client_Policy version =”9.0”> 

<Connections> – Defines the connection profiles in the default.rcf configuration file. There is no hard 
limit defined on the number of connection profiles allowed.

<Connection name = connection name> – Provides a name for the VPN connection that appears in 
the Global VPN Client window.

<Description> description text</Description> – Provides a description for each 
connection profile that appears when the user moves the mouse pointer over the VPN 
Policy in the Global VPN Client window. The maximum number of characters for the 
<Description> tag is 1023.

<Flags> 
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<AutoConnect>[Off=0]/On=1</AutoConnect> – Enables this connection when 
program is launched.

<ForceIsakmp>Off=0/[On=1]</ForceIsakmp> – Starts IKE negotiation as soon as 
the connection is enabled without waiting for network traffic. If disabled, then 
only traffic to the destination network(s) initiates IKE negotiations.

<ReEnableOnWake>[Off=0]/On=1</ReEnableOnWake> – Enables the connection 
when computer is coming out of sleep or hibernation.

<ReconnectOnError>Off=0/[On=1]</ReconnectOnError> – Automatically keeps 
trying to enable the connection when an error occurs.

<ExecuteLogonScript>[Disable=0]/Enable=1</ExecuteLogonScript> – Forces 
launch login script.

</Flags> 

<Peer> – Defines the peer settings for a VPN connection. A VPN connection can support up 
to 5 peers.

<HostName>IP Address/Domain Name</HostName> – The IP address or domain 
name of the Dell SonicWALL gateway.

<EnableDeadPeerDetection>Off=0/On=1</EnableDeadPeerDetection> – Enables 
detection if the Peer stops responding to traffic. This sends Vendor ID to the Dell 
SonicWALL appliance during IKE negotiation to enable Dead peer-detection heart 
beat traffic. 

<ForceNATTraversal>[Off=0]/On=1</ForceNATTraversal> – Forces NAT traversal 
even without a NAT device in the middle. Normally, NAT devices in the middle are 
detected automatically, and UDP encapsulation of IPSEC traffic starts after IKE 
negotiation is complete.

<DisableNATTraversal>[Off=0]/On=1</DisableNATTraversal> – Disables NAT 
traversal even without a NAT device in the middle. Normally, NAT devices in the 
middle are detected automatically, and UDP encapsulation of IPSEC traffic starts 
after IKE negotiation is complete.

<NextHop>IP Address</NextHop> – The IP Address of the next hop for this 
connection. 

<Timeout>[3]<Timeout> – Defines timeout value in seconds for packet 
retransmissions. The minimum <Timeout> value is 1 second, and the maximum 
value is 10 seconds. 

<Retries>[3]<Retries> – Number of times to retry packet retransmissions before 
the connection is considered as dead. The minimum <Retries>value is 1, and the 
maximum value is 10.

<UseDefaultGWAsPeerIP>[Off=0]/On=1</UseDefaultGWAsPeerIP> – Specifies that 
the PC’s Default Gateway IP Address is used as the Peer IP Address.

<WaitForSourceIP>Off=0/[On=1]</WaitForSourceIP> – Specifies that packets are 
to be sent when a local source IP address is available.

NOTE: NAT Traversal - There is a drop down selection list containing the following three 
items:

• Automatic - Detects if NAT Traversal is on or off.

• Forced On - Forces NAT Traversal On.

• Disabled - Forces NAT Traversal Off.

To specify Automatic in a custom default.rcf file, set ForceNATTraversal and 
DisableNATTraversal to 0, or do not list these tags at all.

IMPORTANT: <NextHop> is ONLY used if there is a need to use a next hop that is different 
from the default gateway.
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<DPDInterval>[[3]-30]</DPDInterval> – Specifies the duration of time (in seconds) 
to wait before declaring a peer as dead. The allowed values for the interval times 
are 3, 5, 10, 15, 20, 25 and 30 seconds.

<DPDAttempts>[3-[5]]</DPDAttempts> – Specifies number of unsuccessful 
attempts to contact a peer before declaring it as dead. The allowed values are 3, 
4, or 5 times.

<DPDAlwaysSend>[Off=0]/On=1</DPDAlwaysSend> – Instructs the Global VPN 
Client to send a DPD packet based on network traffic received from the peer.

</Peer> – For redundant gateways on this connection, repeat all the tags under <Peer>. 
There can be up to 5 redundant gateways for each connection. 

</Connection> – Defines the end of each connection profile in the configuration file. 

</Connections> – Defines the end of all connection profiles in the Default.rcf file.

</SW_Client_Policy> 

Sample default.rcf file
The following is an example of a default.rcf file. This file includes two VPN connections: Corporate Firewall 
and Overseas Office. The Corporate Firewall connection configuration includes two peer entries for redundant 
VPN connectivity.  

<?xml version="1.0" standalone="yes"?> 

<SW_Client_Policy version="9.0"> 

<Connections> 

<Connection name="Corporate Firewall"> 

<Description>This is the corporate firewall. Call 1-800-fix-today for connection 
problems.</Description> 

<Flags>

<AutoConnect>0</AutoConnect>

<ForceIsakmp>1</ForceIsakmp>

<ReEnableOnWake>0</ReEnableOnWake>

<ReconnectOnError>1</ReconnectOnError>

<ExecuteLogonScript>0</ExecuteLogonScript>

</Flags>

<Peer>

<HostName>CorporateFW</HostName>

<EnableDeadPeerDetection>1</EnableDeadPeerDetection>

<ForceNATTraversal>0</ForceNATTraversal>

<DisableNATTraversal>0</DisableNATTraversal>

<NextHop>0.0.0.0</NextHop>

<Timeout>3</Timeout>

<Retries>3</Retries>

CAUTION: If you attempt to directly copy this sample file to an ASCII text editor, you may have to 
remove all of the paragraph marks at the end of each line before saving it. Verify the file can be 
imported into the Global VPN Application before distributing it.
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<UseDefaultGWAsPeerIP>0</UseDefaultGWAsPeerIP>

<InterfaceSelection>0</InterfaceSelection>

<WaitForSourceIP>0</WaitForSourceIP>

<DPDInterval>3</DPDInterval>

<DPDAttempts>3</DPDAttempts>

<DPDAlwaysSend>0</DPDAlwaysSend>

</Peer>

<Peer>

<HostName>1.2.3.4</HostName>

<EnableDeadPeerDetection>1</EnableDeadPeerDetection>

<ForceNATTraversal>0</ForceNATTraversal>

<DisableNATTraversal>0</DisableNATTraversal>

<NextHop>0.0.0.0</NextHop>

<Timeout>3</Timeout>

<Retries>3</Retries>

<UseDefaultGWAsPeerIP>0</UseDefaultGWAsPeerIP>

<InterfaceSelection>0</InterfaceSelection>

<WaitForSourceIP>0</WaitForSourceIP>

<DPDInterval>3</DPDInterval>

<DPDAttempts>3</DPDAttempts>

<DPDAlwaysSend>0</DPDAlwaysSend>

</Peer>

</Connection>

<Connection name="Overseas Gateway">

<Description>This is the firewall to connect when traveling overseas.</Description>

<Flags>

<AutoConnect>0</AutoConnect>

<ForceIsakmp>1</ForceIsakmp>

<ReEnableOnWake>0</ReEnableOnWake>

<ReconnectOnError>1</ReconnectOnError>

<ExecuteLogonScript>0</ExecuteLogonScript>

</Flags>

<Peer>

<HostName>&lt;Default Gateway&gt;</HostName>

<EnableDeadPeerDetection>1</EnableDeadPeerDetection>

<ForceNATTraversal>0</ForceNATTraversal>

<DisableNATTraversal>0</DisableNATTraversal>

<NextHop>0.0.0.0</NextHop>

<Timeout>3</Timeout>

<Retries>3</Retries>
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<UseDefaultGWAsPeerIP>1</UseDefaultGWAsPeerIP>

<InterfaceSelection>0</InterfaceSelection>

<WaitForSourceIP>0</WaitForSourceIP>

<DPDInterval>3</DPDInterval>

<DPDAttempts>3</DPDAttempts>

<DPDAlwaysSend>0</DPDAlwaysSend>

</Peer>

</Connection>

</Connections>

</SW_Client_Policy>

Troubleshooting the default.rcf file
Issue Solution

If there are any incorrect entries or typos in your 
default.rcf file, the settings in the default.rcf file are 
not incorporated into the Global VPN Client, and no 
connection profiles appear in the Global VPN Client 
window. Either the error message:

• Failed to parse configuration <file>, appears 
in the Global VPN Client Log Viewer.

• Could not import the specified configuration 
file. The file appears to be corrupt, is 
displayed when attempting to import the file. 

Ensure that the file does not contain any non-ASCII 
characters. The Connections.rcf file created by the 
default.rcf file must be deleted from the \ directory 
and the default.rcf file edited to correct the errors.

The default.rcf file cannot have an attribute of Read 
Only.

The Connections.rcf file created by the default.rcf 
file must be deleted from the \ directory and the 
default.rcf file Read Only attribute removed to 
correct the error.

The Peer Name, <Default Gateway>, displays the 
following error message when attempting to connect: 
Failed to convert the Peer name <Default Gateway> 
to an IP address. 

When setting the Peer Name to the special case of 
<Default Gateway>, the tag for 
<UseDefaultGWAsPeerIP> must be set to 1. The 
Connections.rcf file created by the default.rcf file 
must be deleted from the \ directory.
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Using the Global VPN Client CLI

• About the Global VPN Client CLI on page 62

• Command line options on page 62

• Command line examples on page 62

About the Global VPN Client CLI
The Dell SonicWALL Global VPN Client can run from the Command Line Interface (CLI). This interface allows for 
the programmatic or script-based initiation of certain Global VPN Client functions without requiring the user to 
directly act in the Global VPN Client application. The Global VPN Client CLI enables the setting up of scripts that 
automatically initiate a secure tunnel anytime a particular application or connection method is started.

The CLI commands require the use of a complete path name to the Global VPN Client application followed by 
various flags and variable information such as username or password.

Command line options
You can use the following options to perform a variety of Global VPN Client actions from the command line.

• /E “Connection Name” – Enables the specific connection.

• /D “Connection Name” – Disables the specific connection.

• /Q - Quits a running an instance of the program. Ignored if program is not already running.

• /A [filename] - Starts the program and sends all messages to the specified log file. If no log file is 
specified, the default file name is gvcauto.log. If the program is already running, this option is ignored.

• /U “Username” - Username to pass to XAUTH. Must be used in conjunction with /E.

• /P “Password” - Password to pass to XAUTH. Must be used in conjunction with /E.

Command line examples
• <path>\swgvpnclient - runs/starts application. If application is already running, it does not create 

another instance.

• <path>\swgvpnclient /E <connection name> /U <username> and /P <password> - runs/starts the 
application and enables the named connection and use the <username> and <password> for user 
authentication. If you do not include a username and password. the Global VPN Client presents a dialog 
asking for the information in order to continue.

CAUTION: Embedding a user’s password directly in a script is a security risk. Anyone who can gain 
access to the script can read the password to circumvent security. It is recommended that scripts or 
programmatic dashboards ask for the password before initiating a connection and then clear the 
variable.
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• <path>\swgvpnclient /A <path\filename> - runs/starts the application and enables auto logging of all 
events to a log file. If the filename is not specified, then the log file is created with the default name 
<gvcauto.log>. If you want to save the autolog for each Global VPN Client session, you can use the 
filename option and specify a different filename each time the application is started. If the path is not 
specified, this file is created in the same directory where the Global VPN Client application is started.
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Log Viewer messages

• About Log Viewer messages on page 64

• Error messages on page 64

• Info messages on page 69

• Warning messages on page 72

About Log Viewer messages
The following sections list the Error, Info, and Warning messages that can appear in the Global VPN Client Log 
Viewer.

Error messages
Type Message

ERROR "Invalid DOI in notify message,"

ERROR : called with invalid parameters.

ERROR A phase 2 IV has already been created.

ERROR An error occurred.

ERROR Attributes were specified but not offered.

ERROR Authentication algorithm is not supported.

ERROR CA certificate not found in list.

ERROR Calculated policy configuration attributes length does not match length of attributes set into 
policy configuration payload.

ERROR Calculated XAuth attributes length does not match length of attributes set into XAuth 
payload.

ERROR Can not change the Diffie-Hellman group for PFS.

ERROR Can not process packet that does not have at least one payload.

ERROR Can not process unsupported mode config type.

ERROR Can not process unsupported XAuth type.

ERROR Can not set IPSEC proposals into empty SA list.

ERROR Cannot do quick mode: no SA's to negotiate.

ERROR Certificate error.

ERROR Certificate ID not specified.

ERROR Deallocation of event publisher context failed.

ERROR Diffie-Hellman group generator length has not been set.

ERROR Diffie-Hellman group prime length has not been set.
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ERROR DSS signature processing failed - signature is not valid.

ERROR Encryption algorithm is not supported.

ERROR ESP transform algorithm is not supported.

ERROR Failed to add a new AH entry to the phase 2 SA list.

ERROR Failed to add a new ESP entry to the phase 2 SA list.

ERROR Failed to add IPSEC encapsulation mode into the payload.

ERROR Failed to add IPSEC group description into the payload.

ERROR Failed to add IPSEC HMAC algorithm into the payload.

ERROR Failed to add IPSEC life duration into the payload.

ERROR Failed to add IPSEC life type into the payload.

ERROR Failed to add OAKLEY authentication algorithm into the payload.

ERROR Failed to add OAKLEY encryption algorithm into the payload.

ERROR Failed to add OAKLEY generator G1 into the payload.

ERROR Failed to add OAKLEY group description into the payload.

ERROR Failed to add OAKLEY group type into the payload.

ERROR Failed to add OAKLEY hash algorithm into the payload.

ERROR Failed to add OAKLEY life duration into the payload.

ERROR Failed to add OAKLEY life type into the payload.

ERROR Failed to add OAKLEY prime P into the payload.

ERROR Failed to add policy configuration INI format into the payload.

ERROR Failed to add policy configuration version into the payload.

ERROR Failed to add XAuth password '' into the payload.

ERROR Failed to add XAuth status into the payload.

ERROR Failed to add XAuth type into the payload.

ERROR Failed to add XAuth username '' into the payload.

ERROR Failed to allocate bytes.

ERROR Failed to allocate memory.

ERROR Failed to begin phase 1 exchange.

ERROR Failed to begin quick mode exchange.

ERROR Failed to build a DSS object.

ERROR Failed to build dead peer detection packet.

ERROR Failed to build dead peer detection reply message.

ERROR Failed to build dead peer detection request message.

ERROR Failed to build phase 1 delete message.

ERROR Failed to calculate DES mode from ESP transfer.

ERROR Failed to calculate policy configuration attributes length.

ERROR Failed to calculate XAuth attributes length.

ERROR Failed to compute IV for connection entry.

ERROR Failed to construct certificate payload.

ERROR Failed to construct certificate request payload.

ERROR Failed to construct certificate.

ERROR Failed to construct destination proxy ID payload.

ERROR Failed to construct DSS signature.

Type Message
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ERROR Failed to construct hash payload.

ERROR Failed to construct IPSEC nonce payload.

ERROR Failed to construct IPSEC SA payload.

ERROR Failed to construct ISAKMP blank hash payload.

ERROR Failed to construct ISAKMP delete hash payload.

ERROR Failed to construct ISAKMP DPD notify payload.

ERROR Failed to construct ISAKMP ID payload.

ERROR Failed to construct ISAKMP info hash payload.

ERROR Failed to construct ISAKMP key exchange payload.

ERROR Failed to construct ISAKMP nonce payload.

ERROR Failed to construct ISAKMP notify payload.

ERROR Failed to construct ISAKMP packet header.

ERROR Failed to construct ISAKMP phase 1 delete payload.

ERROR Failed to construct ISAKMP SA payload.

ERROR Failed to construct ISAKMP vendor ID payload (ID = ).

ERROR Failed to construct mode config hash payload.

ERROR Failed to construct NAT discovery payload.

ERROR Failed to construct PFS key exchange payload.

ERROR Failed to construct policy provisioning payload.

ERROR Failed to construct quick mode hash payload.

ERROR Failed to construct quick mode packet.

ERROR Failed to construct responder lifetime payload.

ERROR Failed to construct RSA signature.

ERROR Failed to construct signature payload.

ERROR Failed to construct source proxy ID payload.

ERROR Failed to construct XAuth payload.

ERROR Failed to convert the peer name to an IP address.

ERROR Failed to create a new connection entry: an entry already exists with ID.

ERROR Failed to create connection entry with message ID.

ERROR Failed to decrypt buffer.

ERROR Failed to decrypt mode config payload.

ERROR Failed to decrypt notify payload.

ERROR Failed to decrypt packet.

ERROR Failed to decrypt quick mode payload.

ERROR Failed to encrypt mode config payload.

ERROR Failed to encrypt notify payload.

ERROR Failed to encrypt packet.

ERROR Failed to encrypt quick mode payload.

ERROR Failed to expand packet to size bytes.

ERROR Failed to find an SA list for PROTO_IPSEC_AH.

ERROR Failed to find an SA list for PROTO_IPSEC_ESP.

ERROR Failed to find an SA list given the protocol.

ERROR Failed to find certificate with ID.

Type Message
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ERROR Failed to find connection entry for message ID.

ERROR Failed to find exit interface to reach.

ERROR Failed to find MAC address in the system interfaces table.

ERROR Failed to find matching SA list.

ERROR Failed to find message ID and matching cookies in the connection entry list.

ERROR Failed to find message ID in the connection entry list.

ERROR Failed to find message ID in the SA list.

ERROR Failed to find OAKLEY group specified in the SA payload.

ERROR Failed to find private key for certificate with ID.

ERROR Failed to find protocol ID in the SA list.

ERROR Failed to find route to reach.

ERROR Failed to find sequence number.

ERROR Failed to find source IP address to reach.

ERROR Failed to flush the system ARP cache.

ERROR Failed to generate Diffie-Hellman parameters.

ERROR Failed to generate quick mode initiator key.

ERROR Failed to generate quick mode responder key.

ERROR Failed to generate SKEYID.

ERROR Failed to get the size of the system interfaces table.

ERROR Failed to get the size of the system IP address table.

ERROR Failed to get the system interface table.

ERROR Failed to get the system IP address table.

ERROR Failed to get transforms from SA list.

ERROR Failed to match initiator cookie.

ERROR Failed to match responder cookie.

ERROR Failed to parse certificate data.

ERROR Failed to parse configuration file.

ERROR Failed to read the size of an incoming ISAKMP packet.

ERROR Failed to re-allocate bytes.

ERROR Failed to receive an incoming ISAKMP packet.

ERROR Failed to receive an incoming ISAKMP packet. The length is incorrect.

ERROR Failed to send an outgoing ISAKMP packet.

ERROR Failed to set policy configuration attributes into payload.

ERROR Failed to set proposals into phase 1 SA payload.

ERROR Failed to set proposals into phase 2 SA payload.

ERROR Failed to set responder lifetype attributes.

ERROR Failed to set the ESP attributes from the SA payload into the SA.

ERROR Failed to set the IPSEC AH attributes into the phase 2 SA.

ERROR Failed to set the IPSEC ESP attributes into the phase 2 SA.

ERROR Failed to set the OAKLEY attributes into the phase 1 SA.

ERROR Failed to set vendor ID into packet payload.

ERROR Failed to set XAuth attributes into payload.

ERROR Failed to sign hash.

Type Message
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ERROR Failed to verify certificate signature.

ERROR Failed to verify informational message hash payload.

ERROR Failed to verify mode config message hash payload.

ERROR Hash algorithm is not supported.

ERROR Hash Payload does not match.

ERROR Hash size invalid:

ERROR Header invalid (verified)!

ERROR Invalid certificate: ASN sequence is not correct.

ERROR Invalid certificate: payload length is too small.

ERROR Invalid hash payload.

ERROR Invalid payload. Possible overrun attack!

ERROR Invalid SA state: 

ERROR Invalid signature payload.

ERROR Invalid SPI size.

ERROR is not a supported Diffie-Hellman group type.

ERROR is not a supported DOI.

ERROR is not a supported exchange type.

ERROR is not a supported ID payload type.

ERROR is not a supported IPSEC protocol.

ERROR is not a supported notify message type.

ERROR is not a supported payload type.

ERROR is not a supported policy configuration attribute type.

ERROR is not a supported policy configuration message type.

ERROR is not a supported proxy ID payload type.

ERROR is not a supported XAuth attribute type.

ERROR is not a valid quick mode state.

ERROR is not a valid XAuth message type.

ERROR is not a valid XAuth status.

ERROR ISAKMP SA delete msg for a different SA!

ERROR No certificate for CERT authentication.

ERROR No entry in the system IP address table was found with index.

ERROR No KE payload while PFS configured mess_id.

ERROR Out of memory.

ERROR Phase 1 authentication algorithm is not supported.

ERROR Phase 1 encryption algorithm is not supported.

ERROR Protocol ID has already been added to the SA list.

ERROR Protocol mismatch: expected PROTO_IPSEC_AH but got.

ERROR Protocol mismatch: expected PROTO_IPSEC_ESP but got.

ERROR Publisher deregistration failed.

ERROR Responder cookie is not zero.

ERROR RSA signature processing failed - signature is not valid.

ERROR SA hash function has not been set in.

ERROR Signature Algorithm mismatch is X.509 certificate.

Type Message
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Info messages

ERROR Signature verification failed!

ERROR The certificate is not valid at this time.

ERROR The current state is not valid for processing mode config payload.

ERROR The current state is not valid for processing signature payload.

ERROR The first payload is not a hash payload.

ERROR The following error occurred while trying to open the configuration file:

ERROR The peer is not responding to phase 1 ISAKMP requests.

ERROR The peer is not responding to phase 1 ISAKMP requests.

ERROR The state flag indicates that the IPSEC SA payload has not been processed.

ERROR The system interface table is empty.

ERROR The system IP address table is empty.

ERROR Unable to compute hash! 

ERROR Unable to compute shared secret for PFS in phase 2!

ERROR Unable to read configuration file.

ERROR User did not enter XAuth next pin.

ERROR XAuth CHAP requests are not supported at this time.

ERROR XAuth failed.

ERROR XAuth has requested a password but one has not yet been specified.

Type Message

INFO "The connection """" has been disabled."

INFO A certificate is needed to complete phase 1.

INFO A phase 2 SA can not be established with until a phase 1 SA is established.

INFO A pre-shared key is needed to complete phase 1.

INFO AG failed. SA state unknown. Peer: 

INFO An incoming ISAKMP packet from was ignored.

INFO DSS g value:

INFO DSS p value:

INFO DSS q value:

INFO Event publisher deregistered.

INFO Event publisher registered for.

INFO Failed to negotiate configuration information with.

INFO Found CA certificate in CA certificate list.

INFO Ignoring unsupported payload.

INFO Ignoring unsupported vendor ID.

INFO ISAKMP phase 1 proposal is not acceptable.

INFO ISAKMP phase 2 proposal is not acceptable.

INFO MM failed. Payload processing failed. OAK_MM_KEY_EXCH. Peer:

INFO MM failed. Payload processing failed: OAK_MM_NO_STATE. Peer: 

INFO MM failed. Payload processing failed: OAK_MM_SA_SETUP. Peer:

Type Message
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INFO MM failed. SA state not matching mask process auth. Peer:

INFO MM failed. SA state not matching mask process key. Peer:

INFO MM failed. SA state not matching mask process sa. Peer:

INFO MM failed. SA state unknown. Peer:

INFO NAT Detected: Local host is behind a NAT device.

INFO NAT Detected: Peer is behind a NAT device.

INFO peer certificate missing key value.

INFO Phase 1 has completed.

INFO Phase 1 SA lifetime set to.

INFO Phase 2 negotiation has failed.

INFO Phase 2 SA lifetime set to.

INFO Phase 2 with has completed.

INFO Proposal not acceptable: not authentication algorithm specified.

INFO Proposal not acceptable: not Diffie-Hellman group specified.

INFO Proposal not acceptable: not encryption algorithm specified.

INFO Proposal not acceptable: not hash algorithm specified.

INFO Proposal not acceptable: proposal not found in list.

INFO QM failed. Load SA failed. Peer: 

INFO Reading configuration file.

INFO Ready to negotiate phase 2 with.

INFO Received address notification notify.

INFO Received attributes not supported notify.

INFO Received authentication failed notify.

INFO Received bad syntax notify.

INFO Received certificate unavailable notify.

INFO Received dead peer detection acknowledgement.

INFO Received dead peer detection request.

INFO Received initial contact notify.

INFO Received invalid certificate authentication notify.

INFO Received invalid certificate encoding notify.

INFO Received invalid certificate notify.

INFO Received invalid certificate request syntax notify.

INFO Received invalid cookie notify.

INFO Received invalid exchange type notify.

INFO Received invalid flags notify.

INFO Received invalid ID information notify.

INFO Received invalid key info notify.

INFO Received invalid major version notify.

INFO Received invalid message ID notify.

INFO Received invalid minor version notify.

INFO Received invalid payload notify.

INFO Received invalid protocol ID notify.

INFO Received invalid signature notify.

Type Message
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INFO Received invalid SPI notify.

INFO Received invalid transform ID notify.

INFO Received malformed payload notify.

INFO Received no proposal chosen notify.

INFO Received notify SA lifetime notify.

INFO Received phase 1 delete message.

INFO Received phase 2 delete message for SPI.

INFO Received policy provisioning acknowledgement.

INFO Received policy provisioning OK.

INFO Received policy provisioning update.

INFO Received policy provisioning version reply.

INFO Received policy provisioning version request.

INFO Received responder lifetime notify.

INFO Received situation not supported notify.

INFO Received unequal payload length notify.

INFO Received unknown notify.

INFO Received unsupported DOI notify.

INFO Received unsupported exchange type notify.

INFO Received XAuth request.

INFO Received XAuth status.

INFO Re-evaluating ID info after INVALID_ID_INFO message.

INFO Releasing IP address for the virtual interface ().

INFO Renewing IP address for the virtual interface ().

INFO Saving configuration file.

INFO Sending dead peer detection acknowledgement.

INFO Sending dead peer detection request.

INFO Sending phase 1 delete.

INFO Sending phase 2 delete for.

INFO Sending policy provisioning acknowledgement.

INFO Sending policy provisioning version reply.

INFO Sending XAuth acknowledgement.

INFO Sending XAuth reply.

INFO Signature Verified!

INFO Dell SonicWALL Global VPN Client version.

INFO Dell SonicWALL VPN Client.

INFO Starting aggressive mode phase 1 exchange.

INFO Starting authentication negotiation.

INFO Starting configuration negotiation.

INFO Starting ISAKMP phase 1 negotiation.

INFO Starting ISAKMP phase 2 negotiation with.

INFO Starting main mode phase 1 exchange.

INFO Starting quick mode phase 2 exchange.

INFO The configuration for the connection has been updated.

Type Message
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Warning messages

INFO The configuration for the connection is up to date.

INFO The configuration has been updated and must be reloaded.

INFO The connection has entered an unknown state.

INFO The connection is idle.

INFO The hard lifetime has expired for phase 1.

INFO The hard lifetime has expired for phase 2 with.

INFO The IP address for the virtual interface has been released.

INFO The IP address for the virtual interface has changed to.

INFO The ISAKMP port (500) is already in use. Port will be used as the ISAKMP source port.

INFO The peer is not responding to phase 2 ISAKMP requests to.

INFO The phase 1 SA has been deleted.

INFO The phase 1 SA has died.

INFO The phase 2 SA has been deleted.

INFO The phase 2 SA has died.

INFO The SA lifetime for phase 1 is seconds.

INFO The SA lifetime for phase 2 is seconds.

INFO The soft lifetime has expired for phase 1.

INFO The soft lifetime has expired for phase 2 with.

INFO The system ARP cache has been flushed.

INFO Unable to encrypt payload!

INFO User authentication has failed.

INFO User authentication has succeeded.

INFO User authentication information is needed to complete the connection.

INFO XAuth has requested a username but one has not yet been specified.

Type Message

WARNING A password must be entered.

WARNING AG failed. SA state not matching mask process auth. Peer:

WARNING AG failed. SA state not matching mask process key. Peer:

WARNING AG failed. State OAK_AG_INIT_EXCH is invalid when responder. Peer:

WARNING AG failed. State OAK_AG_NO_STATE is invalid when initiator. Peer:

WARNING Failed to process aggressive mode packet.

WARNING Failed to process final quick mode packet.

WARNING Failed to process informational exchange packet.

WARNING Failed to process main mode packet.

WARNING Failed to process mode configuration packet.

WARNING Failed to process packet payloads.

WARNING Failed to process payload.

WARNING Failed to process quick mode packet.

WARNING Ignoring AUTH message when aggressive mode already complete. Peer:

Type Message
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WARNING Invalid DOI in delete message: 

WARNING Invalid IPSEC SA delete message.

WARNING Invalid ISAKMP SA delete message.

WARNING is not a supported OAKLEY attribute class.

WARNING Protocol ID is not supported in SA payloads.

WARNING Received an encrypted packet when not crypto active!

WARNING Received an unencrypted packet when crypto active!

WARNING Responder lifetime protocol is not supported.

WARNING The password is incorrect. Please re-enter the password.

WARNING The pre-shared key dialog was cancelled by the user. The connection will be disabled.

WARNING The select certificate dialog was cancelled by the user. The connection will be disabled.

WARNING The username/password dialog was cancelled by the user. The connection will be disabled.

WARNING Unable to decrypt payload!

Type Message
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D

Warranty and licensing

• Limited Warranty on page 74

• End User License Agreement on page 74

Limited Warranty
Dell, Inc. warrants that commencing from the delivery date to Customer (but in any case commencing not more 
than ninety (90) days after the original shipment by Dell), and continuing for a period of twelve (12) months, 
that the product will be free from defects in materials and workmanship under normal use. This Limited 
Warranty is not transferable and applies only to the original end user of the product. Dell and its suppliers' 
entire liability and Customer's sole and exclusive remedy under this limited warranty will be shipment of a 
replacement product. At Dell’s discretion the replacement product may be of equal or greater functionality and 
may be of either new or like-new quality. Dell’s obligations under this warranty are contingent upon the return 
of the defective product according to the terms of Dell’s then-current Support Services policies. 

This warranty does not apply if the product has been subjected to abnormal electrical stress, damaged by 
accident, abuse, misuse or misapplication, or has been modified without the written permission of Dell. 

DISCLAIMER OF WARRANTY. EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED CONDITIONS, 
REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OR CONDITION 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, SATISFACTORY QUALITY OR 
ARISING FROM A COURSE OF DEALING, LAW, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED TO THE 
MAXIMUM EXTENT ALLOWED BY APPLICABLE LAW. TO THE EXTENT AN IMPLIED WARRANTY CANNOT BE EXCLUDED, 
SUCH WARRANTY IS LIMITED IN DURATION TO THE WARRANTY PERIOD. BECAUSE SOME STATES OR JURISDICTIONS 
DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM JURISDICTION TO JURISDICTION. THIS DISCLAIMER AND EXCLUSION SHALL APPLY EVEN IF THE 
EXPRESS WARRANTY SET FORTH ABOVE FAILS OF ITS ESSENTIAL PURPOSE.

DISCLAIMER OF LIABILITY. DELL'S SOLE LIABILITY IS THE SHIPMENT OF A REPLACEMENT PRODUCT AS DESCRIBED 
IN THE ABOVE LIMITED WARRANTY. IN NO EVENT SHALL DELL OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES 
WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, 
LOSS OF INFORMATION, OR OTHER PECUNIARY LOSS ARISING OUT OF THE USE OR INABILITY TO USE THE 
PRODUCT, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGES HOWEVER CAUSED 
AND REGARDLESS OF THE THEORY OF LIABILITY ARISING OUT OF THE USE OF OR INABILITY TO USE HARDWARE OR 
SOFTWARE EVEN IF DELL OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO 
EVENT SHALL DELL OR ITS SUPPLIERS' LIABILITY TO CUSTOMER, WHETHER IN CONTRACT, TORT (INCLUDING 
NEGLIGENCE), OR OTHERWISE, EXCEED THE PRICE PAID BY CUSTOMER. THE FOREGOING LIMITATIONS SHALL 
APPLY EVEN IF THE ABOVE-STATED WARRANTY FAILS OF ITS ESSENTIAL PURPOSE. BECAUSE SOME STATES OR 
JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE 
ABOVE LIMITATION MAY NOT APPLY TO YOU.

End User License Agreement
PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY DOWNLOADING, INSTALLING OR 
USING THIS PRODUCT, YOU ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR 
ORDERS PLACED OUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO 
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HTTP://SOFTWARE.DELL.COM/LEGAL/STA.ASPX TO VIEW THE APPLICABLE VERSION OF THIS AGREEMENT FOR 
YOUR REGION. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT OR THE APPLICABLE 
VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOWNLOAD, INSTALL OR USE THIS PRODUCT. IF YOU 
HAVE A SIGNED AGREEMENT WITH DELL THAT IS SPECIFICALLY REFERENCED IN AN ORDER THAT IS EXECUTED 
BETWEEN YOU AND DELL, THEN THAT SIGNED AGREEMENT WILL SUPERSEDE THIS AGREEMENT.

This Software Transaction Agreement (the “Agreement”) is made between you, the Customer (“Customer” or 
“You”) and Dell, as defined below. 

1 Definitions. Capitalized terms not defined in context shall have the meanings assigned to them below: 

a “Affiliate” means any legal entity controlling, controlled by, or under common control with a 
party to this Agreement, for so long as such control relationship exists.

b “Appliance” means a computer hardware product upon which the Software is pre-installed and 
delivered. 

c “Dell” means either (i) Dell Software Inc. (“DSI"), with its principal place of business located at 5 
Polaris Way, Aliso Viejo, CA 92656, or (ii) if an Order is placed through an Affiliate of DSI, the 
Affiliate of DSI that executed or approved the Order.

d “Documentation” means the user manuals and documentation that Dell makes available for the 
Software, and all copies of the foregoing.

e “eStore” means Dell’s online Software ordering system located at 
http://software.dell.com/shop/.

f “License Type” means the model by which the Software is licensed (e.g., by server, by mailbox, 
by managed user) as indicated in the applicable Order.

g “Maintenance Services” means Dell’s maintenance and support offering for the Products as 
identified in the Maintenance Services Section below.

h “Order” means the document by which Customer orders the Product(s) or, if Customer orders the 
Product(s) from the eStore, the process by which Customer orders the Product(s). Orders that are 
signed by both Customer and Dell (“Signed Orders”) shall be governed solely by the terms of this 
Agreement and the applicable Order. Orders placed with a Customer purchase order only, Orders 
placed through the eStore and all Orders placed through a Partner shall be governed solely by the 
terms of this Agreement. Any conflicting or additional terms in or accompanying an Order will not 
be binding on Dell unless Dell accepts such terms in writing. Each Order shall be subject to 
approval by Dell and shall represent the Customer’s irrevocable commitment to purchase and pay 
for the Products and/or Maintenance Services stated in the Order.

i “Partner” means a reseller or distributor that is under contract with Dell or another Partner and 
is authorized via such contract to resell the Products and/or Maintenance Services. 

j “Product Guide” means the document located at 
http://software.dell.com/docs/Product_Guide.pdf that contains the Product Terms. 

k “Product Terms” means the terms associated with each License Type and any other terms 
associated with an individual Product. The Product Terms for Products in a Signed Order shall be 
as stated in the Signed Order. If no Product Terms are stated in the Signed Order, if the Order is 
placed with a Customer purchase order only, if the Order is placed through the eStore, or if the 
Order is placed through a Partner, then the Product Terms for such Products shall be as stated in 
the Product Guide as of the date of the Order. 

l “Products” means the Software and Appliance(s) provided to Customer under this Agreement.

m “Software” means the object code version of the software that is provided or made available to 
Customer pursuant to an Order as well as any corrections, enhancements, and upgrades to such 
software that are made available to Customer pursuant to this Agreement, and all copies of the 
foregoing. Software includes On-Premise Software and SaaS Software (as defined in the Software 
License Section), along with software that is delivered on an Appliance.

2 Software License. 

a General. Subject to the terms of this Agreement, Dell grants to Customer, and Customer accepts 
from Dell, a non-exclusive, non-transferable (except as otherwise set forth herein) and non-
sublicensable license to access and use the quantities of each item of Software identified in the 
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applicable Order within the parameters of the Product Terms associated with the applicable 
Software and License Type (the “License”). Except for MSP Licenses (as defined below), 
Customer shall only use the Software to support the internal business operations of itself and its 
worldwide Affiliates.

b On-Premise Software. If Software is delivered to Customer for Customer’s installation and use on 
its own equipment (“On-Premise Software”), the License shall be perpetual (unless otherwise 
stated on the Order) and shall also include the right to (i) make a reasonable number of 
additional copies of the On-Premise Software to be used solely for non-productive archival or 
passive disaster recovery purposes, provided such copies are kept in a secure location and are not 
used for production purposes unless the primary copy of the On-Premise Software is not being 
used for production purposes, and (ii) make and use copies of the Documentation as reasonably 
necessary to support Customer’s authorized users in their use of the On-Premise Software. Each 
License for On-Premise Software shall only be used by Customer in the country in which the On-
Premise Software is initially delivered to Customer.   

c Software as a Service. If an Order provides Customer with a right to access and use Software 
installed on equipment operated by Dell or its suppliers (“SaaS Software”), (i) the License for 
such SaaS Software shall be granted for the duration of the term stated in the Order (the “SaaS 
Term”), as such SaaS Term may be extended by automatic or agreed upon renewals, and (ii) the 
terms set forth in the SaaS Provisions Section of this Agreement shall apply to all use of such 
Software. If any On-Premise Software is provided in connection with SaaS Software, the License 
duration for such On-Premise Software shall be for the corresponding SaaS Term, and Customer 
shall promptly install any updates to the On-Premise Software provided by Dell.

d MSP License. If an Order indicates that Software is to be used by Customer as a managed service 
provider, Customer shall be granted a License to use such Software and the associated 
Documentation to provide Management Services (an “MSP License”). “Management Services” 
include, without limitation, application, operating system, and database implementation, 
performance tuning, and maintenance services provided by Customer to its customers (each, a 
“Client”). Each MSP License is governed by the terms of this Agreement and the MSP terms in the 
Product Guide. 

If an Order for an MSP License expressly permits Customer to install copies of the Software on its 
Clients’ equipment or to provide its Clients access to the Software, then Customer shall ensure 
that (i) each Client only uses the Software and Documentation as part of the Management 
Services provided to it by Customer, (ii) such use is subject to the restrictions and limitations 
contained in this Agreement, including, but not limited to those in the Export Section of this 
Agreement, and the applicable Order, and (iii) each Client cooperates with Dell during any 
compliance review that may be conducted by Dell or its designated agent. At the conclusion of 
any Management Services engagement with a Client, Customer shall promptly remove any 
Software installed on its Client’s computer equipment or require the Client to do the same. 
Customer agrees that it shall be jointly and severally liable to Dell for the acts and omissions of 
its Clients in connection with their use of the Software and Documentation and shall, at its 
expense, defend Dell against any action, suit, or claim brought against Dell by a Client in 
connection with or related to Customer’s Management Services and pay any final judgments or 
settlements as well as Dell’s expenses in connection with such action, suit, or claim.

e Evaluation License. If an Order indicates that Software is to be used by Customer for evaluation 
purposes, or if Software is otherwise obtained from Dell for evaluation purposes, Customer shall 
be granted a License to use such Software and the associated Documentation solely for 
Customer’s own non-production, internal evaluation purposes (an “Evaluation License”). Each 
Evaluation License shall be granted for an evaluation period of up to thirty (30) days from the 
date of delivery of the On-Premise Software or from the date that access is granted to the SaaS 
Software, plus any extensions granted by Dell in writing (the "Evaluation Period"). There is no 
fee for an Evaluation License during the Evaluation Period, however, Customer is responsible for 
any applicable shipping charges or taxes which may be incurred, and any fees which may be 
associated with usage beyond the scope permitted herein. Customer will only be granted one 
Evaluation License per release of any item of Software. Notwithstanding anything otherwise set 
forth in this Agreement, Customer understands and agrees that Evaluation Licenses are provided 
“AS IS” and that Dell does not provide warranties or Maintenance Services for Evaluation 
Licenses.
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f Freeware License. If a freeware version of Software is downloaded by Customer from a Dell 
website, the terms of use of such Software shall be governed by the applicable Freeware 
definition set forth in the Product Guide (a “Freeware License”). Notwithstanding anything 
otherwise set forth in this Agreement, Customer understands and agrees that Freeware Licenses 
are provided “AS IS” and that Dell does not provide warranties or Maintenance Services for 
Freeware Licenses.

g  Use by Service Providers. If Customer contracts with a third party who performs Software 
implementation, configuration, consulting or outsourcing services (a “Service Provider”), the 
Service Provider may use the Software and Documentation provided to Customer hereunder solely 
for purposes of providing such services to Customer, provided that Customer ensures that (i) the 
Service Provider’s use of the Software and Documentation is subject to the restrictions and 
limitations contained in this Agreement, including, but not limited to those in the Export Section, 
and the applicable Order(s), (ii) the Service Provider cooperates with Dell during any compliance 
review that may be conducted by Dell or its designated agent, and (iii) the Service Provider 
promptly removes any Software installed on its computer equipment upon the completion of the 
Service Provider’s need to use the Software as permitted by this Section. Customer agrees that it 
shall be jointly and severally liable to Dell for the acts and omissions of its Service Providers in 
connection with their use of the Software and Documentation. 

3 Restrictions. Except and only to the extent that the exclusions and limits of this Restrictions Section are 
prohibited by applicable law, Customer may not reverse engineer, decompile, disassemble, or attempt to 
discover or modify in any way the underlying source code of the Software, or any part thereof. In 
addition, Customer may not (i) modify, translate, localize, adapt, rent, lease, loan, create or prepare 
derivative works of, or create a patent based on the Products, Documentation or any part thereof, (ii) 
resell, sublicense or distribute the Products or Documentation, (iii) provide, make available to, or permit 
use of the Products, in whole or in part, by any third party (except as expressly set forth herein) without 
Dell's prior written consent, (iv) use the Products or Documentation to create or enhance a competitive 
offering or for any other purpose which is competitive to Dell, (v) remove Software that was delivered on 
an Appliance from the Appliance on which it was delivered and load such Software onto a different 
appliance without Dell’s prior written consent, or (vi) perform or fail to perform any act which would 
result in a misappropriation or infringement of Dell’s intellectual property rights in the Products or 
Documentation. Each permitted copy of the Software and Documentation made by Customer hereunder 
must contain all titles, trademarks, copyrights and restricted rights notices as in the original. Customer 
understands and agrees that the Products may work in conjunction with third party products and 
Customer agrees to be responsible for ensuring that it is properly licensed to use such third party 
products. Notwithstanding anything otherwise set forth in this Agreement, the terms and restrictions set 
forth herein shall not prevent or restrict Customer from exercising additional or different rights to any 
open source software that may be contained in or provided with the Products in accordance with the 
applicable open source licenses. Customer may not use any license keys or other license access devices 
not provided by Dell, including but not limited to “pirate keys”, to install or access the Software. 

4 Proprietary Rights. Customer understands and agrees that (i) the Products are protected by copyright 
and other intellectual property laws and treaties, (ii) Dell, its Affiliates and/or its suppliers own the 
copyright, and other intellectual property rights in the Products, (iii) the Software is licensed, and not 
sold, (iv) this Agreement does not grant Customer any rights to Dell’s trademarks or service marks, and 
(v) Dell reserves any and all rights, implied or otherwise, which are not expressly granted to Customer in 
this Agreement.

5 Title, Risk of Loss and Delivery. Dell, its Affiliates and/or its suppliers own the title to all Software. 
Title and risk of loss to an Appliance shall pass from Dell to Customer upon shipment (unless the 
Appliance is rented, leased or loaned to Customer). Delivery of Products shall be by electronic download 
or FOB Shipping Point. 

6 Payment. Customer agrees to pay to Dell (or, if applicable, the Partner) the fees specified in each Order, 
including any applicable shipping fees. Customer will be invoiced promptly following delivery of the 
Products or prior to the commencement of any Renewal Maintenance Period and Customer shall make all 
payments due to Dell in full within thirty (30) days from the date of each invoice or such other period (if 
any) stated in an Signed Order. Dell reserves the right to charge Customer a late penalty of 1.5% of the 
invoice amount per month (or the maximum rate permitted by law, whichever is the lesser) for any 
amounts payable to Dell by Customer that are not subject to a good faith dispute and that remain unpaid 
after the due date until such amount is paid.
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7 Taxes. The fees stated in an Order may not include taxes. If Dell is required to pay sales, use, property, 
value-added or other taxes based on the Products or Maintenance Services provided under this 
Agreement or on Customer’s use of Products or Maintenance Services, then such taxes shall be billed to 
and paid by Customer. This Section does not apply to taxes based on Dell’s income.

8 Termination. 

This Agreement or the Licenses granted hereunder may be terminated (i) by mutual written agreement 
of Dell and Customer or (ii) by either party for a breach of this Agreement by the other party (or its 
Service Provider) that the breaching party fails to cure to the non-breaching party’s reasonable 
satisfaction within thirty (30) days following its receipt of notice of the breach.

Upon termination of this Agreement or expiration or termination of a License for any reason, all rights 
granted to Customer for the applicable Software shall immediately cease and Customer shall 
immediately: (i) cease using the applicable Software and Documentation, (ii) remove all copies, 
installations, and instances of the applicable Software from all Customer computers and any other 
devices on which the Software was installed, and ensure that all applicable Service Providers and Clients 
do the same, (iii) return the applicable Software to Dell together with all Documentation and other 
materials associated with the Software and all copies of any of the foregoing, or destroy such items, (iv) 
cease using the Maintenance Services associated with the applicable Software, (v) pay Dell or the 
applicable Partner all amounts due and payable up to the date of termination, and (vi) give Dell a 
written certification, within ten (10) days, that Customer, its Service Providers and Clients, as 
applicable, have complied with all of the foregoing obligations. 

9 Survival. Any provision of this Agreement that requires or contemplates execution after (i) termination 
of this Agreement, (ii) a termination or expiration of a License, or (iii) the expiration of a SaaS Term, is 
enforceable against the other party and their respective successors and assignees notwithstanding such 
termination, including, without limitation, the Restrictions, Payment, Taxes, Termination, Survival, 
Warranty Disclaimer, Infringement Indemnity, Limitation of Liability, Confidential Information, 
Compliance Verification, and General Sections of this Agreement. Termination of this Agreement or a 
License shall be without prejudice to any other remedies that the terminating party may have under law, 
subject to the limitations and exclusions set forth in this Agreement.

10 Export. Customer acknowledges that the Products and Maintenance Services are subject to the export 
control laws, rules, regulations, restrictions and national security controls of the United States and other 
applicable foreign agencies (the "Export Controls") and agrees to abide by the Export Controls. Customer 
hereby agrees to use the Products and Maintenance Services in accordance with the Export Controls, and 
shall not export, re-export, sell, lease or otherwise transfer the Products or any copy, portion or direct 
product of the foregoing in violation of the Export Controls. Customer is solely responsible for obtaining 
all necessary licenses or authorizations relating to the export, re-export, sale, lease or transfer of the 
Products and for ensuring compliance with the requirements of such licenses or authorizations. Customer 
hereby (i) represents that Customer is not an entity or person to which shipment of Products, or 
provision of Maintenance Services, is prohibited by the Export Controls; and (ii) agrees that it shall not 
export, re-export or otherwise transfer the Products to (a) any country subject to a United States trade 
embargo, (b) a national or resident of any country subject to a United States trade embargo, (c) any 
person or entity to which shipment of Products is prohibited by the Export Controls, or (d) anyone who is 
engaged in activities related to the design, development, production, or use of nuclear materials, 
nuclear facilities, nuclear weapons, missiles or chemical or biological weapons. Customer shall, at its 
expense, defend Dell and its Affiliates from any third party claim or action arising out of any inaccurate 
representation made by Customer regarding the existence of an export license, Customer’s failure to 
provide information to Dell to obtain an export license or any allegation made against Dell due to 
Customer’s violation or alleged violation of the Export Controls (an “Export Claim”) and shall pay any 
judgments or settlements reached in connection with the Export Claim as well as Dell’s costs of 
responding to the Export Claim.

11 Maintenance Services. 

a Description. Except as otherwise stated in an Order or an amendment to this Agreement, during 
any Maintenance Period and for the applicable fees, Dell shall: 

(i)  Make available to Customer new versions and releases of the Software, including 
Software corrections, enhancements and upgrades, if and when Dell makes them generally 
available without charge as part of Maintenance Services. 
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(ii) Respond to communications from Customer that report Software failures not 
previously reported to Dell by Customer. Nothing in the foregoing shall operate to limit or 
restrict follow up communication by Customer regarding Software failures. 

(iii) Respond to requests from Customer’s technical coordinators for assistance with the 
operational/technical aspects of the Software unrelated to a Software failure. Dell shall 
have the right to limit such responses if Dell reasonably determines that the volume of 
such non-error related requests for assistance is excessive or overly repetitive in nature.

(iv) Provide access to Dell’s software support web site at 
http://software.dell.com/support/ (the “Support Site”). 

(v) For Customers that have purchased a License to use Software in the “Privileged 
Account” family of products (“PA Software”) and have purchased Maintenance Services 
for the PA Software continuously since the purchase of such License, provide the 
Privileged Account Appliance Replacement Program (as described in the Product Guide) 
for the Appliance on which the PA Software is delivered (the “PA Appliance”).

(vi) For Customers that have purchased a License to use Software in the “SonicWALL” 
family of products (“SNWL Software”) and have purchased Maintenance Services for the 
SNWL Software continuously since the purchase of such License, provide the SonicWALL 
Appliance Replacement Program (as described in the Product Guide) for the Appliance 
on which the SNWL Software is delivered (the “SNWL Appliance”).

Maintenance Services are available during regional business support hours (“Business 
Hours”) as indicated on the Support Site, unless Customer has purchased 24x7 Support. 
The list of Software for which 24x7 Support is available and/or required is listed in the 
Global Support Guide on the Support Site.    

The Maintenance Services for Software that Dell has obtained through an acquisition or 
merger may, for a period of time following the effective date of the acquisition or merger, 
be governed by terms other than those in this Section. The applicable different terms, if 
any, shall be stated on the Support Site.

b Maintenance Period. Except as otherwise stated below, for On-Premise Software, the first period 
for which Customer is entitled to receive Maintenance Services begins on the date of the initial 
delivery of the Software following an Order and ends twelve (12) months thereafter unless 
otherwise set forth in the applicable Order (the “Initial Maintenance Period”). Following the 
Initial Maintenance Period, Maintenance Services for On-Premise Software shall automatically 
renew for additional terms of twelve (12) months (each, a “Renewal Maintenance Period”) at 
the prices stated on the Maintenance renewal Quotation unless the renewal has been cancelled 
by either party giving written notice, by email or otherwise, to the other at least sixty (60) days 
prior to the first day of the applicable Renewal Maintenance Period. For purposes of this 
Agreement, the Initial Maintenance Period and each Renewal Maintenance Period shall be 
considered a “Maintenance Period.” For the avoidance of doubt, this Agreement shall apply to 
each Renewal Maintenance Period. Cancellation of Maintenance Services for perpetual licenses 
for On-Premise Software will not terminate Customer’s rights to continue to use the On-Premise 
Software. Maintenance fees shall be due in advance of each Renewal Maintenance Period and 
shall be subject to the payment requirements set forth in this Agreement. The procedure for 
reinstating Maintenance Services for On-Premise Software after it has lapsed is posted at 
https://support.software.dell.com/essentials/Reinstate-Maintenance-Services. 

For SaaS Software, the Maintenance Period is equal to the duration of the applicable SaaS Term. 
For non-perpetual Licenses for On-Premises Software or for non-perpetual MSP Licenses, the 
Maintenance Period is equal to the duration of the License.

Maintenance Services for the SNWL Software and SNWL Appliances (collectively, “SNWL 
Maintenance”) are optional and purchased separately. If SNWL Maintenance is purchased 
concurrently with the purchase of the SNWL Appliance, the Initial Maintenance Period for such 
SNWL Maintenance begins on the date Customer registers the SNWL Appliance with Dell. If SNWL 
Maintenance is purchased after the initial purchase of the SNWL Appliance, then the Initial 
Maintenance Period for such SNWL Maintenance begins when Customer initiates SNWL 
Maintenance in its MySonicWall account (as such account may be renamed by Dell in its sole 
discretion).   

12 Warranties and Remedies. 
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a Software Warranties. Dell warrants that, during the applicable Warranty Period (as defined in 
subsection (c) below), 

(i) the operation of the Software, as provided by Dell, will substantially conform to its 
Documentation (the “Operational Warranty”); 

(ii) the Software, as provided by Dell, will not contain any viruses, worms, Trojan Horses, 
or other malicious or destructive code designed by Dell to allow unauthorized intrusion 
upon, disabling of, or erasure of the Software, except that the Software may contain a key 
limiting its use to the scope of the License granted, and license keys issued by Dell for 
temporary use are time-sensitive (the “Virus Warranty”):  

(iii) the media provided by Dell, if any, on which the On-Premise Software is recorded will 
be free from material defects in materials and workmanship under normal use (the 
“Media Warranty”); and 

(iv) it will make commercially reasonable efforts to make the SaaS Software available 
twenty-four hours a day, seven days a week except for scheduled maintenance, the 
installation of updates, those factors that are beyond the reasonable control of Dell, 
Customer’s failure to meet any minimum system requirements communicated to Customer 
by Dell, and any breach of this Agreement by Customer that impacts the availability of the 
SaaS Software (the “SaaS Availability Warranty”).

b Appliance Warranties. Except for the PA Appliance and the SNWL Appliance, Appliances are 
warranted in accordance with the warranty document delivered with the Appliance and/or 
included on the hardware manufacturers’ website. For the PA Appliance and the SNWL Appliance, 
Dell warrants that, during the applicable Warranty Period, the PA Appliance and the SNWL 
Appliance will operate in a manner which allows the PA Software and the SNWL Software, 
respectively, to be used in substantial conformance with the Documentation (the “PA Appliance 
Warranty” and “SNWL Appliance Warranty”, respectively).

c Warranty Periods. The “Warranty Period” for each of the above warranties shall be as follows: 
(i) for the Operational Warranty as it applies to On-Premise Software, the Virus Warranty and the 
Media Warranty, thirty (30) days following the initial delivery of the Software following an 
Approved Order; (ii) for the Operational Warranty as it applies to SaaS Software and the SaaS 
Availability Warranty, the duration of the SaaS Term; (iii) for the PA Appliance Warranty, one (1) 
year following the initial delivery of the PA Appliance following an Order; and (iv) for the SNWL 
Appliance Warranty, one (1) year following the date the SNWL Appliance is registered with Dell by 
Customer. 

d Remedies. Any breach of the foregoing warranties must be reported by Customer to Dell during 
the applicable Warranty Period. Customer’s sole and exclusive remedy and Dell’s sole obligation 
for any such breach shall be as follows:

(i) For a breach of the Operational Warranty that impacts the use of On-Premise 
Software, Dell shall correct or provide a workaround for reproducible errors in the 
Software that caused the breach within a reasonable time considering the severity of the 
error and its effect on Customer or, at Dell’s option, refund the license fees paid for the 
nonconforming Software upon return of such Software to Dell and termination of the 
related License(s) hereunder.

(ii) For a breach of the Operational Warranty that impacts the use of SaaS Software, Dell 
shall correct or provide a workaround for reproducible errors in the Software that caused 
the breach and provide a credit or refund of the fees allocable to the period during which 
the Software was not operating in substantial conformance with the applicable 
Documentation.

(iii) For a breach of the Virus Warranty, Dell shall replace the Software with a copy that is 
in conformance with the Virus Warranty. 

(iv)  For a breach of the Media Warranty, Dell shall, at its expense, replace the defective 
media.

(v) For a breach of the SaaS Availability Warranty, Dell shall provide a credit or refund of 
the fees allocable to the period during which the Software was not available for use.
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(vi) For a breach of the PA Appliance Warranty or the SNWL Appliance Warranty, Dell shall 
fulfill its obligations under the applicable Appliance Replacement Program.

Additional Product-specific warranties and remedies may be stated in an Signed Order. 

e Warranty Exclusions. The warranties set forth in this Section shall not apply to any non-
conformance (i) that Dell cannot recreate after exercising commercially reasonable efforts to 
attempt to do so; (ii) caused by misuse of the applicable Product or by using the Product in a 
manner that is inconsistent with this Agreement or the Documentation; or (iii) arising from the 
modification of the Product by anyone other than Dell. 

f Third Party Products. Certain Software may contain features designed to interoperate with 
third-party products. If the third-party product is no longer made available by the applicable 
provider, Dell may discontinue the related product feature. Dell shall notify Customer of any such 
discontinuation, however Customer will not be entitled to any refund, credit or other 
compensation as a result of the discontinuation. 

g Warranty Disclaimer. THE EXPRESS WARRANTIES AND REMEDIES SET FORTH IN THIS SECTION OR IN 
A SIGNED ORDER ARE THE ONLY WARRANTIES AND REMEDIES PROVIDED BY DELL HEREUNDER. TO 
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ALL OTHER WARRANTIES OR REMEDIES ARE 
EXCLUDED, WHETHER EXPRESS OR IMPLIED, ORAL OR WRITTEN, INCLUDING ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, NON-INFRINGEMENT, 
SATISFACTORY QUALITY, AND ANY WARRANTIES ARISING FROM USAGE OF TRADE OR COURSE OF 
DEALING OR PERFORMANCE. DELL DOES NOT WARRANT UNINTERRUPTED OR ERROR-FREE 
OPERATION OF THE PRODUCTS.

h High-Risk Disclaimer. CUSTOMER UNDERSTANDS AND AGREES THAT THE PRODUCTS ARE NOT 
FAULT-TOLERANT AND ARE NOT DESIGNED OR INTENDED FOR USE IN ANY HIGH-RISK OR 
HAZARDOUS ENVIRONMENT, INCLUDING WITHOUT LIMITATION, THE OPERATION OF NUCLEAR 
FACILITIES, AIRCRAFT NAVIGATION, AIR TRAFFIC CONTROL, LIFE SUPPORT MACHINES, WEAPONS 
SYSTEMS, OR ANY OTHER APPLICATION WHERE THE FAILURE OR MALFUNCTION OF ANY PRODUCT 
CAN REASONABLY BE EXPECTED TO RESULT IN DEATH, PERSONAL INJURY, SEVERE PROPERTY 
DAMAGE OR SEVERE ENVIRONMENTAL HARM (A “HIGH RISK ENVIRONMENT”). ACCORDINGLY, (I) 
CUSTOMER SHOULD NOT USE THE PRODUCTS IN A HIGH RISK ENVIRONMENT, (II) ANY USE OF THE 
PRODUCTS BY CUSTOMER IN A HIGH RISK ENVIRONMENT IS AT CUSTOMER’S OWN RISK, (III) DELL, 
ITS AFFILIATES AND SUPPLIERS SHALL NOT BE LIABLE TO CUSTOMER IN ANY WAY FOR USE OF THE 
PRODUCTS IN A HIGH RISK ENVIRONMENT, AND (IV) DELL MAKES NO WARRANTIES OR ASSURANCES, 
EXPRESS OR IMPLIED, REGARDING USE OF THE PRODUCTS IN A HIGH RISK ENVIRONMENT.

13 Infringement Indemnity. Dell shall indemnify Customer from and against any claim, suit, action, or 
proceeding brought against Customer by a third party to the extent it is based on an allegation that the 
Software directly infringes any patent, copyright, trademark, or other proprietary right enforceable in 
the country in which the Software is delivered to Customer, or misappropriates a trade secret in such 
country (a “Claim”). Indemnification for a Claim shall consist of the following: Dell shall (a) defend or 
settle the Claim at its own expense, (b).pay any judgments finally awarded against Customer under a 
Claim or any amounts assessed against Customer in any settlements of a Claim, and (c) reimburse 
Customer for the reasonable administrative costs or expenses, including without limitation reasonable 
attorneys’ fees, it necessarily incurs in responding to the Claim. Dell’s obligations under this 
Infringement Indemnity Section are conditioned upon Customer (i) giving prompt written notice of the 
Claim to Dell, (ii) permitting Dell to retain sole control of the investigation, defense or settlement of the 
Claim, and (iii) providing Dell with such cooperation and assistance as Dell may reasonably request from 
time to time in connection with the investigation, defense or settlement of the Claim. Dell shall have no 
obligation hereunder to defend Customer against any Claim (a) resulting from use of the Software other 
than as authorized in this Agreement, (b) resulting from a modification of the Software other than by 
Dell, (c) based on Customer’s use of the Software after Dell recommends discontinuation because of 
possible or actual infringement, (d) based on Customer’s use of a superseded or altered release of 
Software if the infringement would have been avoided by use of a current or unaltered release of the 
Software made available to Customer, or (e) to the extent the Claim arises from or is based on the use of 
the Software with other products, services, or data not supplied by Dell if the infringement would not 
have occurred but for such use. If Customer’s use of the Software is enjoined as a result of a Claim, Dell 
shall, at its expense and option either (1) obtain for Customer the right to continue using the enjoined 
Software, (2) replace the enjoined Software with a functionally equivalent non-infringing product, (3) 
modify the enjoined Software so that it is non-infringing, or (4) terminate the License for the enjoined 
Software and (A) for On-Premise Software, accept the return of the enjoined Software and refund the 
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license fee paid for such Software, pro-rated over a sixty (60) month period from the date of initial 
delivery of the Software following an Order, or (B) for SaaS Software, discontinue Customer’s right to 
access and use the enjoined Software and refund the unused pro-rated portion of any license fees pre-
paid by Customer for such Software. This Section states Dell’s entire liability and its sole and exclusive 
indemnification obligations with respect to a Claim. 

14 Limitation of Liability. EXCEPT FOR (A) ANY BREACH OF THE RESTRICTIONS OR CONFIDENTIAL 
INFORMATION SECTIONS OF THIS AGREEMENT, (B) AMOUNTS CONTAINED IN JUDGMENTS OR SETTLEMENTS 
WHICH DELL IS LIABLE TO PAY ON BEHALF OF CUSTOMER UNDER THE INFRINGEMENT INDEMNITY SECTION 
OF THIS AGREEMENT AND CUSTOMER IS LIABLE TO PAY ON BEHALF OF OR TO DELL UNDER THE CONDUCT, 
EXPORT, MSP LICENSE, AND USE BY SERVICE PROVIDERS SECTIONS OF THIS AGREEMENT, OR (C) ANY 
LIABILITY TO THE EXTENT LIABILITY MAY NOT BE EXCLUDED OR LIMITED AS A MATTER OF APPLICABLE 
LAW, IN NO EVENT SHALL CUSTOMER OR ITS AFFILIATES OR DELL, ITS AFFILIATES OR SUPPLIERS BE LIABLE 
FOR  ANY INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL LOSS OR DAMAGE OF ANY KIND, 
INCLUDING BUT NOT LIMITED TO LOSS OF REVENUE, LOSS OF ACTUAL OR ANTICIPATED PROFITS, LOSS OF 
BUSINESS, LOSS OF CONTRACTS, LOSS OF GOODWILL OR REPUTATION, LOSS OF ANTICIPATED SAVINGS, 
LOSS OF, DAMAGE TO OR CORRUPTION OF DATA, HOWSOEVER ARISING, WHETHER SUCH LOSS OR DAMAGE 
WAS FORESEEABLE OR IN THE CONTEMPLATION OF THE PARTIES AND WHETHER ARISING IN OR FOR 
BREACH OF CONTRACT, TORT (INCLUDING NEGLIGENCE), BREACH OF STATUTORY DUTY, OR OTHERWISE.

EXCEPT FOR (A) ANY BREACH OF THE SOFTWARE LICENSE, RESTRICTIONS, OR CONFIDENTIAL 
INFORMATION SECTIONS OF THIS AGREEMENT, OR ANY OTHER VIOLATION OF THE OTHER PARTY’S 
INTELLECTUAL PROPERTY RIGHTS; (B) DELL’S EXPRESS OBLIGATIONS UNDER THE INFRINGEMENT 
INDEMNITY SECTION OF THIS AGREEMENT AND CUSTOMER’S EXPRESS OBLIGATIONS UNDER THE CONDUCT, 
EXPORT, MSP LICENSE, AND USE BY SERVICE PROVIDERS SECTIONS OF THIS AGREEMENT, (C) DELL’S COSTS 
OF COLLECTING DELINQUENT AMOUNTS WHICH ARE NOT THE SUBJECT OF A GOOD FAITH DISPUTE; (D) A 
PREVAILING PARTY’S LEGAL FEES PURSUANT TO THE LEGAL FEES SECTION OF THIS AGREEMENT; OR (E) 
ANY LIABILITY TO THE EXTENT LIABILITY MAY NOT BE EXCLUDED OR LIMITED AS A MATTER OF APPLICABLE 
LAW, THE MAXIMUM AGGREGATE AND CUMULATIVE LIABILITY OF CUSTOMER AND ITS AFFILIATES AND 
DELL, ITS AFFILIATES AND SUPPLIERS, UNDER THIS AGREEMENT, WHETHER ARISING IN OR FOR BREACH OF 
CONTRACT, TORT (INCLUDING NEGLIGENCE), BREACH OF STATUTORY DUTY, OR OTHERWISE, SHALL NOT 
EXCEED (Y) THE GREATER OF THE FEES PAID AND/OR OWED (AS APPLICABLE) BY CUSTOMER OR ITS 
AFFILIATES FOR THE PRODUCTS THAT ARE THE SUBJECT OF THE BREACH OR FIVE HUNDRED DOLLARS 
($500.00), OR (Z) FOR MAINTENANCE SERVICES OR A PRODUCT SUBJECT TO RECURRING FEES, THE 
GREATER OF THE AMOUNT PAID AND/OR OWED (AS APPLICABLE) FOR SUCH MAINTENANCE SERVICE OR 
PRODUCT DURING THE TWELVE (12) MONTHS PRECEDING THE BREACH OR FIVE HUNDRED DOLLARS 
($500.00).  THE PARTIES AGREE THAT THESE LIMITATIONS OF LIABILITY ARE AGREED ALLOCATIONS OF RISK 
CONSTITUTING IN PART THE CONSIDERATION FOR DELL PROVIDING PRODUCTS AND SERVICES TO 
CUSTOMER, AND SUCH LIMITATIONS WILL APPLY NOTWITHSTANDING THE FAILURE OF THE ESSENTIAL 
PURPOSE OF ANY LIMITED REMEDY AND EVEN IF A PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
LIABILITIES OR FAILURES.

Dell’s Affiliates and suppliers and Customer’s Affiliates shall be beneficiaries of this Limitation of 
Liability Section and Customer’s Clients and Service Providers are entitled to the rights granted under 
the MSP License and Use by Service Providers Sections of this Agreement; otherwise, no third party 
beneficiaries exist under this Agreement. Dell expressly excludes any and all liability to Customer’s 
Service Providers, Clients and to any other third party.

15 Confidential Information. 

a Definition. “Confidential Information” means information or materials disclosed by one party 
(the “Disclosing Party”) to the other party (the “Receiving Party”) that are not generally 
available to the public and which, due to their character and nature, a reasonable person under 
like circumstances would treat as confidential, including, without limitation, financial, 
marketing, and pricing information, trade secrets, know-how, proprietary tools, knowledge and 
methodologies, the Software (in source code and/or object code form), information or 
benchmark test results regarding the functionality and performance of the Software, any 
Software license keys provided to Customer, and the terms and conditions of this Agreement.  

Confidential Information shall not include information or materials that (i) are generally known to 
the public, other than as a result of an unpermitted disclosure by the Receiving Party after the 
date that Customer accepts the Agreement (the “Effective Date”); (ii) were known to the 
Receiving Party without an obligation of confidentiality prior to receipt from the Disclosing Party; 
(iii) the Receiving Party lawfully received from a third party without that third party’s breach of 
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agreement or obligation of trust; (iv) are protected by Dell in accordance with its obligations 
under the Protected Data Section below, or (v) are or were independently developed by the 
Receiving Party without access to or use of the Disclosing Party’s Confidential Information. 

b Obligations. The Receiving Party shall (i) not disclose or permit disclosure of the Disclosing 
Party’s Confidential Information to any third party, except as permitted in subsection (c) below, 
(ii) only use the Disclosing Party’s Confidential Information to exercise the rights granted to it 
under this Agreement, and (iii) protect the Disclosing Party’s Confidential Information from 
unauthorized use or disclosure by exercising at least the same degree of care it uses to protect its 
own similar information, but in no event less than a reasonable degree of care. The Receiving 
Party shall promptly notify the Disclosing Party of any known unauthorized use or disclosure of 
the Disclosing Party’s Confidential Information and will cooperate with the Disclosing Party in any 
litigation brought by the Disclosing Party against third parties to protect its proprietary rights. For 
the avoidance of doubt, this Section shall apply to all disclosures of the parties’ Confidential 
Information as of the Effective Date, whether or not specifically arising from a party’s 
performance under this Agreement.

c Permitted Disclosures. Notwithstanding the foregoing, the Receiving Party may disclose the 
Disclosing Party’s Confidential Information without the Disclosing Party’s prior written consent to 
any of its Affiliates, directors, officers, employees, consultants, contractors or representatives 
(collectively, the “Representatives”), but only to those Representatives that (i) have a “need to 
know” in order to carry out the purposes of this Agreement or to provide professional advice in 
connection with this Agreement, (ii) are legally bound to the Receiving Party to protect 
information such as the Confidential Information under terms at least as restrictive as those 
provided herein, and (iii) have been informed by the Receiving Party of the confidential nature of 
the Confidential Information and the requirements regarding restrictions on disclosure and use as 
set forth in this Section. The Receiving Party shall be liable to the Disclosing Party for the acts or 
omissions of any Representatives to which it discloses Confidential Information which, if done by 
the Receiving Party, would be a breach of this Agreement. 

Additionally, it shall not be a breach of this Section for the Receiving Party to disclose the 
Disclosing Party’s Confidential Information as may be required by operation of law or legal 
process, provided that the Receiving Party provides prior notice of such disclosure to the 
Disclosing Party unless expressly prohibited from doing so by a court, arbitration panel or other 
legal authority of competent jurisdiction.

16 Protected Data. For purposes of this Section, “Protected Data” means any information or data that is 
provided by Customer to Dell during this Agreement that alone or together with any other information 
relates to an identified or identifiable natural person or data considered to be personal data as defined 
under Privacy Laws, and “Privacy Laws” means any applicable law, statute, directive or regulation 
regarding privacy, data protection, information security obligations and/or the processing of Protected 
Data.

Except as permitted herein or to the extent required by Privacy Laws or legal process, Dell shall not 
disclose Protected Data to any third party for any reason. Dell shall implement appropriate technical and 
organizational measures to prevent unauthorized disclosure of or access to Protected Data by third 
parties, and shall only store and process Protected Data as required to fulfill its obligations under this 
Agreement and any applicable Orders. Dell shall make reasonable efforts to comply with Customer’s 
written instructions with respect to the Protected Data; however, Dell shall have no liability to Customer 
for any breach of this Section resulting from Dell’s acts or omissions in accordance with any such 
instructions. Dell shall promptly notify Customer of any disclosure of or access to the Protected Data by 
a third party in breach of this Section and shall cooperate with Customer to reasonably remediate the 
effects of such disclosure or access. Dell further affirms to Customer that Dell Software Inc. currently 
abides by the safe harbor framework as set forth by the U.S. Department of Commerce regarding the 
collection, use and retention of data from the European Union. 

Customer hereby (i) represents that it has the right to send the Protected Data to Dell, (ii) consents for 
Dell to store and use the Protected Data worldwide for the sole purpose of performing its obligations 
under this Agreement and any applicable Orders, (iii) agrees that the Protected Data may be accessed 
and used by Dell and its Representatives worldwide as may be needed to support Dell’s standard business 
operations, and (iv) agrees that Protected Data consisting of Customer contact information (e.g., email 
addresses, names) provided as part of Maintenance Services may be sent to Dell’s third party service 
providers as part of Dell’s services improvement processes.   
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17 Compliance Verification. Customer agrees to maintain and use systems and procedures to accurately 
track, document, and report its installations, acquisitions and usage of the Software. Such systems and 
procedures shall be sufficient to determine if Customer’s deployment of the Software or, if applicable, 
use of the SaaS Software is within the quantities, Product Terms, and maintenance releases to which it is 
entitled. Dell or its designated auditing agent shall have the right to audit Customer's deployment of the 
Software or, if applicable, use of the SaaS Software for compliance with the terms and conditions of this 
Agreement and the applicable Order(s). Any such audits shall be scheduled at least ten (10) days in 
advance and shall be conducted during normal business hours at Customer's facilities. Customer shall 
provide its full cooperation and assistance with such audit and provide access to the applicable records 
and computers. Without limiting the generality of the foregoing, as part of the audit, Dell may request, 
and Customer agrees to provide, a written report, signed by an authorized representative, listing 
Customer's then current deployment of On-Premise Software and/or the number of individuals that have 
accessed and used SaaS Software. If Customer's deployment of the Software or, if applicable, use of the 
SaaS Software is found to be greater than its purchased entitlement to such Software, Customer will be 
invoiced for the over-deployed quantities at Dell’s then current list price plus the applicable 
Maintenance Services and applicable over-deployment fees. All such amounts shall be payable in 
accordance with this Agreement. Additionally, if the unpaid fees exceed five percent (5%) of the fees 
paid for the applicable Software, then Customer shall also pay Dell's reasonable costs of conducting the 
audit. The requirements of this Section shall survive for two (2) years following the termination of the 
last License governed by this Agreement.

18 SaaS Provisions. 

a Data. Customer may store data on the systems to which it is provided access in connection with 
its use of the SaaS Software (the “SaaS Environment”). Dell may periodically make back-up 
copies of Customer data, however such back-ups are not intended to replace Customer’s 
obligation to maintain regular data backups or redundant data archives. Customer is solely 
responsible for collecting, inputting and updating all Customer data stored in the SaaS 
Environment, and for ensuring that it does not (i) knowingly create and store data that actually or 
potentially infringes or misappropriates the copyright, trade secret, trademark or other 
intellectual property right of any third party, or (ii) use the SaaS Environment for purposes that 
would reasonably be seen as obscene, defamatory, harassing, offensive or malicious. If the Order 
states where Customer data is to be stored, Dell will not move the data from the specified region 
without notifying Customer, except if Dell is required to do so by law or legal process. Dell shall 
have the right to delete all Customer data stored in connection with the use of the SaaS Software 
thirty (30) days following any termination of this Agreement or any License to SaaS Software 
granted hereunder. 

Customer represents and warrants that it has obtained all rights, permissions and consents 
necessary to use and transfer all Customer and/or third party data within and outside of the 
country in which Customer or the applicable Customer Affiliate is located (including providing 
adequate disclosures and obtaining legally sufficient consents from Customer’s employees, 
customers, agents, and contractors). If Customer transmits data to a third-party website or other 
provider that is linked to or made accessible by the SaaS Software, Customer will be deemed to 
have given its consent to Dell enabling such transmission and Dell shall have no liability to 
Customer in connection with any claims by a third party in connection with such transmission.

b Conduct. In connection with the use of SaaS Software, Customer may not (i) attempt to use or 
gain unauthorized access to Dell’s or to any third-party's networks or equipment; (ii) permit other 
individuals or entities to copy the SaaS Software; (iii) provide unauthorized access to or use of 
any SaaS Software or the associated access credentials; (iv) attempt to probe, scan or test the 
vulnerability of the SaaS Software, the SaaS Environment, or a system, account or network of Dell 
or any of Dell’s customers or suppliers; (v) interfere or attempt to interfere with service to any 
user, host or network; (vi) engage in fraudulent, offensive or illegal activity of any nature or 
intentionally engage in any activity that infringes the intellectual property rights or privacy rights 
of any individual or third party; (vii) transmit unsolicited bulk or commercial messages; (viii) 
intentionally distribute worms, Trojan horses, viruses, corrupted files or any similar items; (ix) 
restrict, inhibit, or otherwise interfere with the ability of any other person, regardless of intent, 
purpose or knowledge, to use or enjoy the SaaS Software (except for tools with safety and 
security functions); or (x) restrict, inhibit, interfere with or otherwise disrupt or cause a 
performance degradation to any Dell (or Dell supplier) facilities used to provide the SaaS 
Environment. Customer shall cooperate with Dell’s reasonable investigation of SaaS Environment 
outages, security issues, and any suspected breach of this Section, and shall, at its expense, 
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defend Dell and its Affiliates from any claim, suit, or action by a third party (a “Third Party 
Claim”) alleging harm to such third party caused by Customer’s breach of any of the provisions of 
this Section. Additionally, Customer shall pay any judgments or settlements reached in 
connection with the Third Party Claim as well as Dell’s costs of responding to the Third Party 
Claim. 

c Suspension. Dell may suspend Customer’s use of SaaS Software (a) if so required by law 
enforcement or legal process, (b) in the event of an imminent security risk to Dell or its 
customers, or (c) if continued use would subject Dell to material liability. Dell shall make 
commercially reasonable efforts under the circumstances to provide prior notice to Customer of 
any such suspension.

19 General. 

a Governing Law and Venue. This Agreement shall be governed by and construed in accordance 
with the laws of the State of Texas, without giving effect to any conflict of laws principles that 
would require the application of laws of a different state. Any action seeking enforcement of this 
Agreement or any provision hereof shall be brought exclusively in the state or federal courts 
located in Travis or Williamson County, Texas. Each party hereby agrees to submit to the 
jurisdiction of such courts. 

The parties agree that neither the United Nations Convention on Contracts for the International 
Sale of Goods, nor the Uniform Computer Information Transaction Act (UCITA) shall apply to this 
Agreement, regardless of the states in which the parties do business or are incorporated.  

b Assignment. Except as otherwise set forth herein, Customer shall not, in whole or part, assign or 
transfer any part of this Agreement, the Licenses granted under this Agreement or any other 
rights, interest or obligations hereunder, whether voluntarily, by contract, by operation of law or 
by merger (whether that party is the surviving or disappearing entity), stock or asset sale, 
consolidation, dissolution, through government action or order, or otherwise without the prior 
written consent of Dell. Any attempted transfer or assignment by Customer that is not permitted 
by this Agreement shall be null and void. 

c Severability. If any provision of this Agreement shall be held by a court of competent jurisdiction 
to be contrary to law, such provision will be enforced to the maximum extent permissible by law 
to effect the intent of the parties and the remaining provisions of this Agreement will remain in 
full force and effect. Notwithstanding the foregoing, the terms of this Agreement that limit, 
disclaim, or exclude warranties, remedies or damages are intended by the parties to be 
independent and remain in effect despite the failure or unenforceability of an agreed remedy. 
The parties have relied on the limitations and exclusions set forth in this Agreement in 
determining whether to enter into it.

d Use by U.S. Government. The Software is a “commercial item” under FAR 12.201. Consistent 
with FAR section 12.212 and DFARS section 227.7202, any use, modification, reproduction, 
release, performance, display, disclosure or distribution of the Software or Documentation by the 
U.S. government is prohibited except as expressly permitted by the terms of this Agreement. In 
addition, when Customer is a U.S. government entity, the language in Subsection (ii) of the 
Infringement Indemnity Section of this Agreement and the Injunctive Relief Section of this 
Agreement shall not be applicable.

e Notices. All notices provided hereunder shall be in writing and addressed to the legal department 
of the respective party or to such other address as may be specified in an Order or in writing by 
either of the parties to the other in accordance with this Section. Except as may be expressly 
permitted herein, notices may be delivered personally, sent via a nationally recognized courier or 
overnight delivery service, or mailed by first class mail, postage prepaid. All notices, requests, 
demands or communications shall be deemed effective upon personal delivery or, if sent by mail, 
four (4) days following deposit in the mail in accordance with this paragraph.

f Disclosure of Customer Status. Dell may include Customer in its listing of customers and, upon 
written consent by Customer, announce Customer's selection of Dell in its marketing 
communications. 

g Waiver. Performance of any obligation required by a party hereunder may be waived only by a 
written waiver signed by an authorized representative of the other party, which waiver shall be 
effective only with respect to the specific obligation described therein. Any waiver or failure to 
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enforce any provision of this Agreement on one occasion will not be deemed a waiver of any other 
provision or of such provision on any other occasion.

h Injunctive Relief. Each party acknowledges and agrees that in the event of a material breach of 
this Agreement, including but not limited to a breach of the Software License, Restrictions or 
Confidential Information Sections of this Agreement, the non-breaching party shall be entitled to 
seek immediate injunctive relief, without limiting its other rights and remedies.

i Force Majeure. Each party will be excused from performance for any period during which, and to 
the extent that, it is prevented from performing any obligation or service as a result of causes 
beyond its reasonable control, and without its fault or negligence, including without limitation, 
acts of God, strikes, lockouts, riots, acts of war, epidemics, communication line failures, and 
power failures. For added certainty, this Section shall not operate to change, delete, or modify 
any of the parties’ obligations under this Agreement (e.g., payment), but rather only to excuse a 
delay in the performance of such obligations. 

j Equal Opportunity. Dell Software Inc. is a federal contractor and Affirmative Action employer 
(M/F/D/V) as required by the Equal Opportunity clause C.F.R. § 60-741.5(a).

k Headings. Headings in this Agreement are for convenience only and do not affect the meaning or 
interpretation of this Agreement. This Agreement will not be construed either in favor of or 
against one party or the other, but rather in accordance with its fair meaning. When the term 
“including” is used in this Agreement it will be construed in each case to mean “including, but 
not limited to.”

l Legal Fees. If any legal action is brought to enforce any rights or obligations under this 
Agreement, the prevailing party shall be entitled to recover its reasonable attorneys’ fees, court 
costs and other collection expenses, in addition to any other relief it may be awarded.

m Entire Agreement. This Agreement is intended by the parties as a final expression of their 
agreement with respect to the subject matter thereof and may not be contradicted by evidence 
of any prior or contemporaneous agreement unless such agreement is signed by both parties.  In 
the absence of such an agreement, this Agreement and the applicable Order shall constitute the 
complete and exclusive statement of the terms and conditions and no extrinsic evidence 
whatsoever may be introduced in any judicial or arbitral proceeding that many involve the 
Agreement.    Each party acknowledges that in entering into the Agreement it has not relied on, 
and shall have no right or remedy in respect of, any statement, representation, assurance or 
warranty (whether made negligently or innocently) other than as expressly set out in the 
Agreement. In those jurisdictions where an original (non-faxed, non-electronic, or non-scanned) 
copy of an agreement or an original (non-electronic) signature on agreements such as this 
Agreement or an Order is required by law or regulation, the parties hereby agree that, 
notwithstanding any such law or regulation, a faxed, electronic, or scanned copy of and a 
certified electronic signature on this Agreement or any Order shall be sufficient to create an 
enforceable and valid agreement. In the event of a conflict between the terms of this Agreement 
and the terms contained in an Order, the terms of a Signed Order shall control; for all other 
Orders, the terms of this Agreement shall control.   Neither this Agreement, nor an Order, may be 
modified or amended except by a writing executed by a duly authorized representative of each 
party. No other act, document, usage or custom shall be deemed to amend or modify this 
Agreement or an Order. 
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About Dell
Dell listens to customers and delivers worldwide innovative technology, business solutions and services they 
trust and value. For more information, visit www.software.dell.com.

Contacting Dell
For sales or other inquiries, visit http://software.dell.com/company/contact-us.aspx or call 1-949-754-8000.

Technical support resources
Technical support is available to customers who have purchased Dell software with a valid maintenance 
contract and to customers who have trial versions. 

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a 
day, 365 days a year. In addition, the portal provides direct access to product support engineers through an 
online Service Request system. To access the Support Portal, go to https://support.software.dell.com/.

The site enables you to:

• Create, update, and manage Service Requests (cases)

• View Knowledge Base articles

• Obtain product notifications

• Download software. For trial software, go to Trial Downloads.

• View how-to videos

• Engage in community discussions

• Chat with a support engineer
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